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ABSTRACT 

The principal objectives and scope of the project were to provide a software tracking tool to 

improve decision-making for highway safety. A literature search revealed that purchasing 

and customizing existing software was not feasible and a new solution would be developed in 

house. Requirement gathering and analysis was conducted and documented. The application 

was programmed as a web-based solution for collecting data on low-cost safety 

improvements and analyzing the effectiveness of the improvements. All programming and 

testing was conducted in house. The application was piloted by the Louisiana Department of 

Transportation and Development (DOTD). Minor changes were programmed, as requested. 

Upon DOTD’s satisfaction of the final product, the application and user manual were 

delivered on schedule. 
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IMPLEMENTATION STATEMENT 

Louisiana’s Strategic Highway Safety Plan (SHSP) implementation strategy calls for the 

“aggressive deployment of low cost safety treatments in a systematic manner based on both 

historic data and roadway characteristics.” To assess the effectiveness of the deployed 

improvements, the authors have developed a web-based application with data tracking 

capabilities and an analysis tool. This application provides the DOTD a system that tracks 

and analyzes the effectiveness of safety improvements. This data will improve the decision-

making process for future projects conducted by DOTD.  
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INTRODUCTION 

Intermodal transportation system planning, design, improvement, performance evaluation, and 

economic assessment include safety improvements, because they lower the overall cost of 

transportation. State Departments of Transportation (DOTs) are charged with the development 

and implementation of Strategic Highway Safety Plans (SHSP) as required by the Safe, 

Accountable, Flexible, Efficient Transportation Equity Act – A Legacy for Users (SAFETEA-

LU).  

 

SHSP have broader impacts on passenger and freight transportation than the impact on the 

overall cost of the transportation system. Many states’ SHSPs, as Louisiana’s, include an 

infrastructure focus area that addresses the locations of the majority of serious injury and fatal 

crashes, specifically intersections and roadway departures in the vicinity of curves. Specifically, 

the Federal Highway Administration (FHWA) Highway Safety Improvement Program (HSIP) 

states, “Intersection safety is a national, state, and local priority.” Intersections represent a 

disproportionate share of the safety problem. As a result, organizations such as the FHWA, 

NHTSA, the Institute of Transportation Engineers (ITE), the American Automobile Association 

(AAA), and other private and public organizations are devoting resources to help reduce the 

problem. 

 

Louisiana has been recognized as a “focus” state for intersections by the FHWA. Factors 

included an intersection crash rate that was higher than the national average. Subsequently, 

Louisiana’s SHSP implementation strategy calls for the “aggressive deployment of low-cost 

safety treatments in a systematic manner based on both historic data and roadway 

characteristics.” Many states have the same problems, with respect to intersection and road 

departure crashes, and are at similar stages of deployment of their SHSPs. Thus, evaluating 

roadway safety improvements is a common challenge among all state DOTs.  

 

A system with data tracking and analysis capabilities is required to assess the effectiveness of 

deployed safety improvements. Such a system will allow the DOTs to make better decisions in 

the future based on crash frequencies at the treated locations. This data will improve the 

decision-making process for future projects conducted by DOTs. The specific objectives and 

scope of this project was to provide a software tracking tool to improve decision-making for 

highway safety. The process of adapting existing software was not feasible. A new web-based 

solution was developed to meet the specific requirements and needs of DOTs. 
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OBJECTIVE 

The objective of this research project was to provide an easy to use tool to identify and track the 

effectiveness of treatments and countermeasures for roadway departures related to curves and 

intersection improvements for both local and state roads. Louisiana’s data will be used as a test 

to populate the intersection tool with existing data, test the modules with limited data that 

becomes available, and train personnel in the use and maintenance of the tool. However, the 

software built will be shown to be applicable to other states’ data. 
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SCOPE 

The literature review for this project was based on web searches to determine software solutions 

rather than a review of scientific literature. This review was not a standard literature search, since 

the main objective was to determine if software solutions were available for free or for purchase. 

The lack of appropriate software required the development of a new application. The application 

tracks all safety improvements made by the DOTD, but is applicable to any state DOT. It is not 

meant to serve as an inventory of all signage and pavement applications at a project site. It is 

only to store signage and pavement applications that were removed, replaced, or newly installed 

during the road improvement project. The analysis portion of the new application will provide 

before-and-after crash data for road improvement project sites. 
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METHODOLOGY 

This project was divided into five tasks: Literature Review, Requirement Gathering and 

Analysis, Programming and/or Software Preparation, and Final Report.  

 

Literature Review 

An extensive review was conducted to include all available software that could be used for 

tracking and analyzing highway safety projects. An evaluation was also made of the option of 

developing software in house. This evaluation also included an initial data and system 

requirements analysis. Upon review, it was determined that purchasing an existing configurable 

software package, which could be tailored to this project’s needs, was not a feasible option. 

Justification for developing a new software product, en lieu of purchasing an existing product, is 

discussed within the Discussion of Results section of this report. 

 

Requirement Gathering 

A comprehensive understanding of the end-user needs and requirements was completed by 

meeting with all of the relevant stakeholders. Goals of the system were determined, based on the 

collected requirements, and form the base of the developed application. The functional 

requirements were compiled, documented, and illustrated using appropriate flowcharts and 

diagrams.  

Business Requirements 

The following are the high level business requirements gathered for the application. 

1. Create a standalone database containing all required data (user accounts, road improvements, 

lat/long coordinates of road improvements, crash data, etc.). 

2. Create a project, multiple project locations, and project assignments. 

3. Security in the form of protecting data, preventing unauthorized access, and requiring all users 

to log in. 

NOTE: Each user is assigned one user type. Multiple user types are not assigned to users. 

4. Provide the ability to upload the pre-improvement schematic layout of the work to be 

performed by the contractor and post-improvement photos of said work. 

5. Integrate road, Average Annual Daily Travel (AADT) and crash data to perform “before and 

after” crash analysis. 
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6. Incorporate the Highway Safety Manual (HSM), Crash Modification Factors (CMFs), and 

Safety Performance Functions (SPFs) for rural two-lane roads.  

7. Retrieve pre- and post-improvement schematics and photos for each project location. 

8. Retrieve pre- and post-improvement data for each project location. Data types include: 

a. Safety improvements present and added (list provided by DOTD) 

b. Current size of signage  

c. Added size of signage  

d. Number of signage added 

e. Current number of signage 

f. Date added 

 

 

Figure 1 

Business requirement input and output 

 

Software Design  

The database will be implemented using Microsoft SQL Server 2012 software. The front end of 

the application will be developed using Microsoft Visual Studios in C#, HTML5, JavaScript, and 

Ajax. The application will be deployed and hosted on a HSRG IIS web server.  
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System Architecture  

The data system consists two main parts: a central database management system for the 

uploading, storage, and management of data and a client application to allow users access and 

interact with the data. 

 

Figure 2 

System architecture 

 

Data 

The table structure of the database was designed to include all data identified in the various 

requirements analysis meetings. The data fell in two categories: Captured and Referenced.  

Captured data are entered by the user. This is not pre-existing data within the database. 

Reference data are not completed by the user. This data already exists within the database and 

the user is presented with the appropriate data option based on user selection. See Appendix A 

for the database table structure. [1] 

 

Operating Environment  

The application is functionally efficient and easy to maintain (as required). It operates with the 

following web browsers: Microsoft Internet Explorer, Mozilla Firefox, and Google Chrome. The 

application is accessible from smart devices.  
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Programming and/or Software Preparation 

Programming was based on the requirements analysis and is geared toward the data available 

from DOTD. Existing road data will vary from state to state. An installable software package, 

applicable to other states’ data, was also produced. The code for the application is included, so 

that other state DOTs can configure the application based on the data available to them. Parties 

interested in obtaining the application should contact the LTRC.  

 

Final Report  

This final report includes information on all data compiled and software produced. In addition, 

User and Installation manuals were also written. The User Manual was given to the user (DOTD) 

and provides all operating procedures for the application. The Installation Manual is applicable 

to all other DOTs that will install and configure the software application. Both manuals can be 

found at the end of this report. The requirement of a benefits assessment, for future marketing 

purposes, is located in the Conclusions section of this report. 
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DISCUSSION OF RESULTS 

Existing Software and Resources 

The literature review was not a standard literature search, since the main objective was to 

determine the availability of software solutions. The review was based on web searches to 

determine software solutions rather than a review of scientific literature. 

 

It was determined, based on the review’s findings, that readily available software packages were 

not clearly capable of meeting all of the project objectives. The packages identified were not 

designed to provide the detailed tracking of road improvement projects over years as required for 

this project [1]. Much of the software would have to be modified to meet the specific 

requirements [2]. 

 

While there are some very useful tools available for highway safety, there are currently no free 

software tools readily available that are clearly capable of meeting all of the objectives outlined 

in the proposal [3]. There are few software available that deal with the specific issues addressed 

in this proposal. The most often cited and promoted on the FHWA website is SafetyAnalyst [4]. 

This software was developed as a cooperative effort by FHWA and participating state and local 

agencies. AASHTO manages distribution, technical support, maintenance, and enhancement of 

the software as a licensed AASHTOWare product. 

 

SafetyAnalyst is used by 14 state DOTs to various degrees. The SafetyAnalyst software tools 

require information regarding roadway characteristics, traffic volume, and crash data for the road 

network.  There are some limitations of the software with respect to crash data and traffic flow of 

freeway interchanges that are significantly different from those of basic freeway segments as 

address SafteyAnalyst’s limitations in this regard by instead proposing a different solution using 

GIS and spatial manipulation techniques to identify/separate the interchange data from the basic 

freeway data [5]. They also found that using state-specific SPFs rather than the locally-calibrated 

nation-level SPFs from SafetyAnalyst’s default allowed for a better-fitted model. Overall, while 

SafetyAnalyst provides a set of software tools which can be used by state and local highway 

agencies for highway safety management, the tool is not designed to provide the detailed 

tracking of projects over years as required by this proposal [6]. Much of the software would have 

to be modified to meet the specific requirements.  

 

There are other commercial software products that focuse on analysis crash locations at 

intersections and road segments [7]. But none focus on tracking road improvements specifically.    
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Requirements – Tracking Safety Improvements 

The primary function of the system is a web-based application that allows users to cooperatively 

collect information and location data for road improvement projects. Users have the ability to 

analyze the effectiveness of treatments and countermeasures by comparing location crash rates 

before and after the improvements. The user interface is accessible on standard computer web 

browsers, tablets and portable computer devices. 

User Types and Characteristics 

During the requirements analysis, it was determined that the application should allow for six user 

groups. The roles and responsibilities for each user group are defined below. 

System Administrator.    The system administrator performs project administrative and 

user management tasks. The system administrator’s objectives for the tool are to (1) create, edit, 

delete and deactivate the project manager, data entry, project engineer, viewer, and analyst user 

accounts and (2) perform the same functions as a project manager. This user is not intended to 

have an IT background. During the requirements gathering, it was determined that a project 

manager (described below) would have the duties described in the first objective (above) in 

addition to those of the project manager. However, the application is built so one user can only 

be assigned one User Type role. Therefore, since the objectives of system administrator could not 

be limited to the duties described in the first objective, this user was also granted the same user 

rights as the project manager.  

Project Manager.    The project manager creates projects/locations and assigns/reviews 

tasks. The project manager’s objectives for the tool are to (1) create, modify and/or delete 

projects, (2) create, modify and/or delete project sites,  (3) assign data entry users and project 

engineers to projects and sites, (4) create, modify and/or delete improvements to sites, and (5) 

export completed road improvement project information to generate “before and after” reports. 

Data Entry.   The data entry user creates project sites and site details. The data entry’s 

objectives for the tool are to (1) create, modify and/or delete project sites and (2) create, modify 

and/or delete improvements to sites.  

Project Engineer.   The project engineer adds data to the system, uploads pictures and 

accepts/rejects contractor tasks. The project engineers’ objectives for the tool are to (1) input 

and/or upload site improvement pictures, (2) approve site improvements, and (3) export 

completed road improvement project information. 

Analyst.   The analyst searches road improvement and crash data, and performs analysis 

and calculations using this data and other DOTD databases. The analyst’s objectives for the tool 

are to (1) easily search for safety improvement locations, (2) retrieve “before and after” crash 

analysis results and (3) export analysis results. 
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Viewer.   The viewer views any project information during the project and after project 

completion. The viewer’s objectives for the tool are to (1) view projects, (2) view project sites, 

(3) view project site improvements, and (4) view all pre-improvement and post-improvement 

images. 

 

Functional Process Requirements  

The following is an overview of a project as it is created and resides in the developed system. It 

is not intended to explain how the user will interact with the system interface to accomplish 

specific tasks. Procedures for the completion of tasks is contained in the user manual. The 

contents of that document are included at the end of this report. 

1. Create user profiles – The system administrator creates profiles for users.  

2. Create project – The first step in the lifecycle of a project begins when a project manager 

creates a new project.  

3. Assign data entry users to the project – The project manager selects data entry users to 

add/edit project and/or site information.  

4. Add sites to the project – The project manager or assigned data entry user adds sites to the 

project.  

5. Assign project engineer to each site – The project manager or data entry user selects a project 

engineer for each site.  

6. Add improvements to sites – The project manager or data entry user will add improvements 

to each site.  

7. Add pre-improvement schematic – The project manager or data entry user will upload a 

schematic of the site with the improvements to be made. 

8. Work performed – Improvements at the project site are performed by a contractor. Add post-

improvement images. The project engineer will upload photos of all improvements made at 

the site.  

9. Approval or Rejection of site improvements – The project engineer accepts or rejects the 

project site improvements and enters the total number of post-improvement signs.  

10. Project Site Complete – Construction is complete. All photos and improvements have been 

approved. All project site data is locked and cannot be edited. 

11. Project Complete – A project is complete when all project sites, for the project, have been 

approved.  
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Figure 3 

End-to-end process 
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Requirements – Crash Analysis 

The analysis performed with the application is intended to help analyze the effectiveness of 

treatments and countermeasures by comparing location crash rates before and after the 

improvements. This analysis is restricted to only the locations where safety improvements were 

implemented and tracked with this application. It is part of the web-based application and is not a 

separate application unto itself. Analysis can be performed by all user types. 

Methodology 

The application uses an Empirical Bayes (EB) method to calculate expected crashes for a defined 

period before and after site improvement. The EB method is designed to overcome two issues 

with crash prediction models: sparse datasets and regression to the mean.  Over a short period of 

time, many sites have no or few crashes.  It is unlikely that the short time frame captured the true 

frequency of crashes resulting in low precision for the crash prediction model.  Regression to the 

mean bias can occur when a site experiences an abnormally high or low number of crashes in 

one year followed by a return to a more typical crash frequency the following year.  The EB 

method uses both the observed number of crashes at a site and the predicted number of crashes at 

similar sites based on the Safety Performance Function.  The main equation is given by [10-3] 

and [11-1] in the Highway Safety Manual. 

                  ∏     

 

The expected crash frequency given by [A-4, 5] in HSM is 

                              (   )                  

  
 

    ∑                      
 

                  ∑           
           

 

                 ∑          
           

 

 

Data Requirements.   Required data inputs include crash data from LADOTD for the 

years of study and site characteristics data for the years of study.  Default values are used where 

site characteristics data is unavailable as shown in Appendix C.  Output data are the predicted 

and expected average crash frequency for the sites under consideration. 

Expected Crashes.   The procedure to calculate expected crashes is as follows: 

1. Define the period Y of the study; 



  

16 

 

2. Get the site(s) to be studied; 

3. Get the over-dispersion parameters k for each site; 

4. Get the calibration factor C for each site; 

5. Obtain the number of observed crashes N_obs for each site for each year. 

6. Calculate the predicted number of crashes N_pred for each site for each year: 

a. Calculate      for each site for each year 

b. Calculate       for each site for each year 

                   ∏    
 

 

7. Calculate the EB-constant w for each site for the period y  Y of the study using 

(Appendix_HSM_Part_C, pa: A-22, Eq. A-5) 

  
 

    ∑            
 

 

8. Calculate the expected number of crashes N_expc for the site per period using the EB 

equation using (Appendix_HSM_Part_C, pa: A-22, Eq. A-4): 

                       (   )           

9. Calculate average expected number of crashes for a site over the period of the study using  

     
∑           

   
 

Sample results are displayed in Tables 1 and 2. 
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Security 

 

Access to the application is password protected. The designated system administrator must create 

all user accounts. This ensures that only the appropriate individuals have access to the 

application. 

 

User Access 

A User ID and Password are required to access to application. Users must obtain a user account 

from the system administrator. A user ID and password, which can later be changed by the user, 

are created during the account setup. 

 

Password Reset by the User 

A password is created by the system administrator when setting up all user accounts. This 

password is provided to the user for their initial access. When logged in, the user can change 

their password at any time. The application does not force a user, even upon initial log in, to 

change a password. It is the user’s responsibility to ensure their password remains confidential. 

 

Password Reset by the System Administrator 

If a user cannot remember their log-in password then they must contact the system administrator. 

The system administrator can reset the password and provide the new password to the user. This 

ensures that the application remains accessible to approved users. 

 

Project Management 

The first step in the lifecycle of a project begins when a new project is created. Each project may 

(and often does) contain multiple project sites. Information regarding the overall scope of the 

project is entered when a project is created. 

 

Project Information 

The information captured when creating a project within the application is standard for all 

projects. Fields that contain finite options are presented to the user in a dropdown menu format. 

If the data in a field is not finite then the user manually enters the data. 

State Project Number.   The standard format of every project number is H.######. It 

may be necessary to enter projects into the application out of sequential order. Therefore, the 

application does not auto-generate the number. The user creating the project must manually enter 

the project number. Project numbers will later be associated with projects sites. Each project 

number can be associated with many project sites. Project sites can be associated with many 

project numbers (in the case of multiple site improvements for multiple projects). 
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Region Type.   Each project is considered to be district-wide or parish-wide. Therefore, 

the user selects either District or Parish from a Region Type dropdown menu. Each project can 

be associated by one region type. A region type can be associated with many projects.   

Region.   The region is presented in dropdown menu format. Selections cannot be made 

until the Region Type is chosen, because they are dependent on the previous selection. If region 

type is selected as District then the user will only be presented with the names of the district 

headquarters. If region type is selected as Parish then the user will only be presented a list of 

parish names. This prevents a region type and region data conflict.  

Project Begin and End Dates.   When the user selects the Project Begin Date or Project 

End Date field or selects the dropdown arrows within the fields (depending on the internet 

browser) then a calendar popup displays. The date displays in MM/DD/YYYY format when a 

date is selected from the calendar. The user may also manually enter the date in this format (if 

preferred). The application requires that the end date cannot be before the begin date. 

Project Site Location 

The information captured when creating a project site within the application is standard for all 

project sites. Fields that contain finite options are presented to the user in a dropdown menu 

format. If the data in a field is not finite then the user manually enters the data. 

State Project Number Assignment.   Each project site is assigned to a current project 

(number).  This selection is presented in dropdown menu format due to the finite list of options. 

This prevents the user from entering a non-existent project number.  

Parish Assignment.   The parish location is assigned to each site. This was implemented 

because district-wide projects cover many parishes. This specifies the location within districts of 

each project site. 

Site Type.   Each project site is considered to be an intersection or non-intersection. 

Therefore, the user selects either Intersection or Non-Intersection from a Site Type dropdown 

menu. This must be defined for each site because this information will be utilized when 

performing crash analysis.  

Intersection and LRS ID.  This information must be manually entered by the user. If 

Intersection is selected as the Site Type then an intersection ID should be entered by the user. If 

Non-Intersection is selected as the Site Type then an LRS ID should be entered by the user. This 

entry is independent of the site type, so it is the user’s responsibility to enter the appropriate ID. 

Logmile From and To.   The user must manually enter the begin and end point of the 

project site. These logmile points are on file at the DOTD. An LRS ID can extend for many 

miles. The logmiles mark a smaller segment of an LRS ID. This segment is the location of the 

project site.  

Construction Begin and End Dates.   When the user selects the Construction Begin 

Date or Construction End Date field or selects the dropdown arrows within the fields (depending 
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on the internet browser) then a calendar popup displays. The date displays in MM/DD/YYYY 

format when a date is selected from the calendar. The user may also manually enter the date in 

this format (if preferred). The application requires that the end date not precede the begin date. 

This information will be used in pre- and post-improvement crash analysis, so crashes that occur 

during the construction timeframe will not be included in the analysis.    

 

Documenting Safety Improvements 

A standardized method has been implemented for documenting pre- and post–improvement 

signage and pavement markings. Fields that contain finite options are presented to the user in a 

dropdown menu format. If the data in a field is not finite then the user manually enters the data. 

The data collected are only of those signs or pavement markings related to the implemented low 

cost safety improvements. It is not intended to serve as an inventory of any and all signs and 

pavement markings at the project site. 

Documenting Safety Improvements for Signage    

Information (detailed below) for all existing signs to be replaced is captured. Each sign/size 

combination to be removed will require an entry. New signage is entered into the application in 

the same manner. Each newly installed sign/size combination will also require its own entry. All 

signage information was gathered from the FHWA’s Manual on Uniform Traffic Control 

Devices (MUTCD).   

Sign Selection.   The user chooses the appropriate sign via a dropdown menu.  Image 

icons display beside the sign name and sign code. Icons were created for those signs that are 

(anticipated to be) used the most. An Image not Available icon was created for all other signs.  

The creation of sign images was limited due to project time constraints and the large number of 

signs contained with the MUTCD. 

      Filtering the Dropdown Menu.   The user may filter the contents of the signage dropdown 

by typing a sign name or code. This reduces the size of the list that the user will navigate. It is 

not required that the list is filtered and the user can return to the comprehensive list (if the list 

was previously filtered). 

 Sign Sizes.   The user chooses the appropriate sign size via a dropdown menu. The size 

options available are dependent upon the type of sign selected. Therefore, the sign size options 

have been limited to only those applicable to the sign selected. Due to the various sign shapes, 

the sizes are presented in overall height and overall width (in inches). 

Pre- and Post-Improvement Sign Quantity.   The user manually enters the number of 

signs (of the selected sign name and size combination) that will be replaced. The sign quantity 

after improvements will be zero if the sign was replaced with a larger sign. The larger signs 
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existing quantity will be zero, since the sign/size combination will only exist after the 

improvement. 

Reason for the Signage Changes.   The user chooses the reason for the site 

improvement via a dropdown menu. The user is restricted to a list, in lieu of manual entry, of the 

reasons that account for most improvements. The options and an explanation of each option are:  

Condition – the sign or pavement marking is of unacceptable condition. 

New Install/Marking – the sign or pavement marking does not currently exist at the 

project site. 

Size Increase (Signs) – the sign is to be replaced with a larger version of the same sign 

(regardless of condition). 

Other – improvements made for reasons that are not covered by the previous three 

options.  

Documenting Safety Improvements for Pavement Improvements   

Information (detailed below) for all pavement markings to be implemented or replaced are 

captured. All pavement improvement information was collected during the functional 

requirement gathering process. 

 Pavement Markings.   The user chooses the appropriate pavement improvement via a 

dropdown menu. The user is restricted to a list, in lieu of manual entry, of possible pavement 

marking improvements. 

 Reason for the Pavement Marking Changes.   The user chooses the reason for the site 

improvement via a dropdown menu. This is the same list that is presented for changes in signage. 

The user is restricted to the list, in lieu of manual entry, of the reasons that account for most 

improvements. 

 Construction Type.   The user chooses the appropriate type of construction performed 

via a dropdown menu. The following explains the three options available to the user: 

NEW – new construction; the pavement marking does not currently exist at the project site. 

REMOVE – the pavement marking currently exists at the project site, will be removed, and will 

not exist when construction is complete. 

REPLACE – the pavement marking currently exists at the project site and will be reapplied.  

 

Site Improvement Documentation 

There are two instances when documents must be added to the site.  A pre-improvement PDF 

aerial schematic of the planned improvements and post-improvement JPEG images of the 

completed improvements. 
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Pre-Improvement Documentation 

A PDF document, typically an aerial schematic, of the planned improvements is added when 

signage and pavement markings are being added to a project site. The document type accepted is 

limited to PDF and can consist of a file with multiple pages. This format is widely used and will 

be more easily accessible by various computers. It will not require the user to download a 

specialized, and not so common, document viewer. Only one document can be saved to the Site 

Improvements page. An uploaded schematic will overwrite the previous one. The application 

does not require the addition of the document. If the document upload were to be required then 

any added improvements could not be saved until the upload of the PDF. This allows flexibility 

to the user, so site improvements can be modified at various times.  

Post-Improvement Documentation 

The project engineer user type is able to upload multiple JPEG images of the completed 

improvements. The application does not require the addition of the document. The location of 

images is on the same page as the sign and pavement improvements and pre-improvement PDF 

(Site Improvements page). It can only be added at a later date, so requiring its addition would 

prevent saving project site improvements during the setup process.  

 

Crash Analysis 

A standardized method has been implemented for analyzing location specific crash information. 

The application restricts the user analysis to only the locations where safety improvements were 

implemented and tracked with this application. Fields that contain finite options are presented to 

the user in a dropdown menu format or calendar (for dates). Crash analysis is not limited to only 

the Analyst user type. All users have access to perform crash analysis.  

Project Sites 

Upon sign-in, the user is presented a list of all sites where safety improvements were 

implemented and tracked with this application. The information is in a spreadsheet format. Each 

row represents one project site. The following information is provided for each site: 

State Project Number 

Site Name 

Parish Name 

Site Type 

Intersection ID / LRS ID 

Logmile From 

Logmile To 

Construction Begin Date 
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Construction End Date 

Approval Status 

 

Filter.   The user can reduce the amount of viewable project sites by applying the parish 

filter. This allows the user to view only projects sites within a specific parish as well as reduce 

the number of viewable sites to more easily identify specific sites.  

Site Selection.   The application does not limit the analysis to one project site at a time. 

The user can select as many sites as desired, regardless of project number, parish, or site type 

(intersection vs. non-intersection).  

Timeframe of Comparison 

The before and after crash analysis includes the time period before the installation of treatments 

and countermeasures and the period after the installation is complete. Crashes that may occur at a 

project site during the construction/installation phase will not be reflected in the analysis output. 

To include crashes that occur during this period will not produce an accurate pre- and post-

improvement crash analysis.  

Before and After Period.   The user has the option of performing analysis for one, two 

or three year time periods. The number selected represents the number of years to be analyzed 

before safety improvements were made at the location and the number of years after the safety 

improvements were completed. 

 

The HSM states that, typically, a minimum of three years of crash data is used for analysis. 

Multiple years of data are preferable to avoid the Regression to the Mean (RTM) phenomenon. 

RTM describes a situation in which crash rates are artificially high during the before period and 

would have been reduced even without an improvement to the site. Therefore, the default 

timeframe for this application is three years. Selecting the default will look at data from the three 

years before safety improvement installation began and data from the three years after the 

improvements were installed.  

Analysis Results 

The results page is separated into four sections: sites selected, results from the selected 

timeframe, results for each year within the selected timeframe and an information log. 

Sites Selected.   The project sites selected are presented in the same format as described 

in Project Sites on the previous page. This is a reminder to the user of which project sites were 

selected for analysis. 

 Results from the Selected Timeframe.   Analysis for the entire selected timeframe is 

reflected in the same spreadsheet format. There are two rows of information for each site. The 
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first is the “before” analysis and the second is the “after” analysis. The following information 

and results are provided for each site: 

State Project Number 

Intersection ID / LRS ID 

Site Name 

Site Type 

Logmile From 

Logmile To 

Period 

Begin Date 

End Date 

Total Observed 

Total Predicted 

Total Expected 

Average Observed 

Average Expected 

K 

W 

 Results for Each Year within the Selected Timeframe.   “Before and After” analysis 

for each year within the selected timeframe is reflected in spreadsheet format. There are two 

rows of information for each year and site. For example, if “3” was the timeframe selected then 

there are “before” and “after” analyses for years one, two, and three (six total rows). The 

following information and results are provided for each site: 

State Project Number 

Intersection ID / LRS ID 

Site Name 

Site Type 

Logmile From 

Logmile To 

Period 

Year Begin/End Date 

Observed 

SPF 

Predicted 

AADT (minor, major) 

K 

C 
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CMF 

Information Log.   This section details missing information, in the analysis calculations, 

that were replaced with default values. Any missing data could alter the final results, so this 

information is provided to the user.  

 

Benefits Assessment 

This project developed a single web-based data management application that provides both 

detailed tracking of low-cost road safety improvement projects over years and the ability to 

analyze their effectiveness (in regard to crash reductions).  

 

The web-based feature makes it accessible on standard computer web browsers, tablets and 

portable computer devices. The application’s ability to both collect project data and perform 

analysis means that user access is not limited by location or function. Another benefit of being 

we-based, means that software will not have to be installed on each computer that will access the 

data.  

 

Data quality and reliability is aided by the standardization of how project data is entered into the 

application and by the validation rules that prohibit invalid entries. Project data will grow over 

time as new low cost safety improvements are implemented. This will allow, as crash reduction 

effectiveness is evaluated, for more accurate and cost effective decisions over time. 
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CONCLUSIONS AND RECOMMENDATIONS 

The result of this project is the web-based LaSET application. The site address is 

http://laset.lsu.edu. The discussion of the results explains the reasoning behind the site’s 

functionality. An installable software package applicable to other states’ data was also produced. 

Installation instructions for that package are at the end of this report. 

 

Application Maintenance 

It is recommended that DOTD keep up to date with changes in signage and pavement 

applications. Changes or additions to names, codes, sizes and icons will require updates to the 

database. Additionally, the DOT should keep up to date with changes to the HSM that may affect 

the application’s crash analysis computations. All changes will require the combined efforts of 

LSU HSRG and DOTD, for LaSET, since the HSRG hosts the site on its server.  

 

Personnel and Security 

It is recommended that one employee be designated as the application’s primary system 

administrator. A second employee should also have administrator rights in the event that the 

primary administrator is absent.  

 

This application is accessible to the public, in theory, since it resides on the World Wide Web. 

All efforts and security updates should be applied to ensure that only those with proper access 

rights can navigate beyond the Login page.    

 

Nonessential Inventory 

This application should serve as a repository for low cost safety improvements. It is not intended 

to serve as an inventory of all signage and pavement markings that will exist, as is, before and 

after improvements are applied to a project site. Only signage and pavement markings that are 

replaced or removed should be captured with this application.   

 

User Manual 

The developed manual is specific to the needs of DOTD. A copy of the manual is included at the 

end of this report. It should be modified to suit the needs of individual DOTs. All references to 

LaSET, in verbiage and screen captures, should be removed or replaced. 

 

http://laset.lsu.edu/
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Additional Features  

Any DOT utilizing the application should consider adding a feature that will give the 

administrator the ability to add sign names, codes, sizes, and icons within the application. This 

currently must be done outside of the application, on the database side, by someone with IT 

skillsets that are not held by the typical user.  

 

Consideration should be given to expanding the type of analysis that can be performed with the 

application. This may include crash comparisons of similar road types that received safety 

improvements or how crash rates are affected by each type of improvement. Such analyses are 

outside the scope of this project, but should be addressed in the future. 
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ACRONYMS, ABBREVIATIONS, AND SYMBOLS 

AAA   American Automobile Association 

AADT   Average Annual Daily Travel 

AASHTO  American Association of State Highway and Transportation  

                                    Officials 

CMF   Crash Modification Factor 

DOT   Department of Transportation 

DOTD   Department of Transportation and Development 

FHWA   Federal Highway Administration 

GIS   Geographic Information System 

HSIP   Highway Safety Improvement Program 

HSM   Highway Safety Manual 

ITE   Institute of Transportation Engineers 

JPEG   Joint Photographic Experts Group 

LaSET   Louisiana Safety Evaluation Tool 

LRSID   Linear Reference System Identification 

LSU   Louisiana State University 

LTRC   Louisiana Transportation Research Center 

MUTCD  Manual on Uniform Traffic Control Devices 

NCITEC  National Center of Intermodal Transportation for Economic   

   Competitiveness 

NHTSA  National Highway Traffic Safety Administration 

PDF   Portable Document Format 

RTM   Regression to the Mean 

SAFETEA-LU Safe, Accountable, Flexible, Efficient Transportation Equity Act – A  

   Legacy for Users 

SHSP   Louisiana’s Strategic Highway Safety Plan 

SPF   Safety Performance Function 

VPN   Virtual Private Network 

 

 

 

 



  

30 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

31 

 

REFERENCES 

 

1. “Standard Highway Signs.” FHWA, U.S. Department of Transportation, 2004. 

 

2. Pollack, R.; Cobb, L.; and Tan, C.  FHWA Data and Safety Analysis Tools. Publication 

No. FHWA-SA-09-002. FHWA, U.S. Department of Transportation, 2009. Accessed 

January, 2013. http://safety.fhwa.dot.gov/tools/data_tools/fhwasa09002/ 

 

3. “Crash Modification Factors Clearinghouse.” FHWA, U.S. Department of 

Transportation. Accessed January, 2014. http://www.cmfclearinghouse.org/ 

 

4. “Interactive Highway Safety Design Model (IHSDM),” IHSDMDownload, Accessed 

January, 2013. http://www.ihsdm.org/wiki/Welcome  

 

5. “Highway Safety Manual Case Study 2: Implementing a New Roadway Safety 

Management Process with SafetyAnalyst in Ohio.” FHWA, U.S. Department of 

Transportation. Accessed January, 2013.  

http://www.safetyanalyst.org/whitepapers/module1.pdf 

 

6. Lu, J.; Gan, A.; Haleem, K.; Alluri, P; and Liu, K. Comparing Locally Calibrated and 

SafetyAnalyst-Default Safety Performance Functions for Florida’s Urban Freeways. 

Report No. 12-4730 Proceedings from the 2012 TRB 91st Annual Meeting. Washington, 

D.C., 2012. 

 

7. “Software Tools for Safety Management of Specific Highway Sites.” SafetyAnalyst. 

White Paper for Module 1—Network Screening. August 2010. 

 

8. “GIS-Based Crash Referencing and Analysis System.” Publication No. FHWA-RD-99-

081, Feb. 1999.  

 

 

 

 

 

 

http://safety.fhwa.dot.gov/tools/data_tools/fhwasa09002/
http://www.cmfclearinghouse.org/
http://www.ihsdm.org/wiki/Welcome
http://www.safetyanalyst.org/whitepapers/module1.pdf


  

32 

 

  



  

33 

 

APPENDIX A 

Database Table Structure 

 

 

PROJECT 

PROJECT_PK int 

STATE_PROJECT_NUM nvarchar(12) 

COST money 

REGION_CODE_TYPE nvarchar(12) 

REGION_CODE_ID int 

PROJECT_BEGIN_DATE date 

PROJECT_END_DATE date 

CONTRACTOR nvarchar(250) 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

   

 

SITE 

PROJECT_PK int 

SITE_PK int 

PARISH_NAME nvarchar(255) 

SITE_TYPE nvarchar(16) 

SITE_ID nvarchar(50) 

SITE_NAME nvarchar(255) 

LOGMILE_FROM float 

LOGMILE_TO float 

CONTROL_SECTION nvarchar(6) 

CONSTRUCTION_BEGIN_DATE date 

CONSTRUCTION _END_DATE date 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

 

 

SITE_IMPROVEMENTS 

PROJECT_PK int 

SITE_PK int 

IMP_PK int 

IMP_CODE_ID nvarchar(18) 

SIGN_PK int 

SIGN_EXIST_SIZE nvarchar(10) 

SIGN_QTY_EXISTING int 

SIGN_IMP_SIZE nvarchar(10) 

SIGN_QTY_IMP Int 
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SIGN_CONDITION nvarchar(8) 

PAVEMENT_PK int 

PAVEMENT_EXISTING nvarchar(3) 

PAVEMENT_CONDITION nvarchar(8) 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

SITE_DOCS 

PROJECT_PK int 

SITE_PK int 

DOC_PK int 

DOCUMENT image 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

 

 

SITE_IMPROVEMENT_DOCS 

PROJECT_PK int 

SITE_PK int 

IMP_PK int 

DOC_PK int 

DOCUMENT image 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

 

 

SITE_IMPROVEMENT_APPROVAL 

PROJECT_PK int 

SITE_PK int 

IMP_PK int 

APPROVAL_FLAG boolean 

REASON_DESCRIPTION nvarchar(250) 

SIGN_QTY_APPROVAL int 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

 

 

USER 

USER_PK int 

USER_ID nvarchar(15) 

USER_PASSWORD nvarchar(25) 

USER_EMAIL nvarchar(50) 

USER_NAME_FIRST nvarchar(20) 
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USER_NAME_LAST nvarchar(20) 

USER_ROLE_CODE_ID nvarchar(5) 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID nvarchar(15) 

 

 

PROJECT_MANAGER_STUDENT_WORKER 

ID_PK int 

PROJECT_PK int 

USER_PK int 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

 

 

SITE_PROJECT_ENGINEER 

ID_PK int 

PROJECT_PK int 

SITE_PK int 

USER_PK int 

CREATE_DATE datetime 

CREATE_USER_ID nvarchar(15) 

 

 

CODES 

CODE_TYPE nvarchar(12) 

CODE_ID nvarchar(8) 

CODE_DESCRIPTION nvarchar(40) 

 

 

SIGNS 

SIGN_PK int 

SIGN_ID nvarchar(8) 

SIGN_TYPE nvarchar(15) 

SIGN_COST money 

 

 
SIGNS_SIZE 

SIGN_PK int 

SIGN_SIZE_PK int 

SIGN_SIZE_HEIGHT int 

SIGN_SIZE_WIDTH int 

 

 

SIGNS_CATEGORY 

SIGN_CATEGORY_PK int 

SIGN_PK int 
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SIGN_CATEGORY_NAME nvarchar(11) 

PAVEMENT 

PAVEMENT_PK int 

PAVEMENT_TYPE nvarchar(50) 

PAVEMENT_SUBTYPE nvarchar(50) 

PAVEMENT_ COST money 

  
PARISH 

PARISH_CD int 

PARISH_NAME nvarchar(255) 

DISTRICT_CD int 

 

 

DISTRICT 

DISTRICT_CD int 

DISTRICT_NAME nvarchar(255) 

 

 

INTERSECTION 

TWO_LANE_UID (PK) int 

LOCATION_UID (FK) int 

SEGMENT_LENGTH float 

AADT float 

LENGTH_HORIZONTAL float 

RADII_HORIZONTAL float 

SPIRAL_TRANSITION_PRESENT bit 

SUPERELEVATION_VARIANCE_HORIZONTAL float 

PERCENT_GRADE float 

LANE_WIDTH float 

SHOULDER_TYPE float 

SHOULDER_WIDTH float 

LIGHTNING_PRESENT bit 

DRIVEWAY_DENSITY float 

PASSING_LANE_PRESENT bit 

SHORT_FOUR_LANE_PRESENT float 

CENTER_TWO_LANE_LEFT_TURN_PRESENT bit 

CENTERLINE_RUMBLE_PRESENT bit 

ROADSIDE_HAZARD_RATING bit 

AUTOMATED_SPEED_ENFORCEMENT_USED bit 

CREATE_DATE datetime 

CREATE_USER_ID int 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID int 
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HIGHWAY 

MULTI_LANE_UID (PK) int 

LOCATION_UID (FK) int 

SEGMENT_LENGTH float 

AADT float 

LANE_WIDTH float 

SHOULDER_WIDTH float 

LIGHTING_PRESENT bit 

AUTOMATED_SPEED_ENFORCEMENT_USED bit 

SLIDESLOPE float 

MEDIAN_WIDTH float 

CREATE_DATE datetime 

CREATE_USER_ID int 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID int 

 

 
DOTD_CRASH 

CRASH_UID (PK) int 

CRASH_NUM nvarchar(20) 

DOTD_CRASH_NUM int 

HWY_TYPE_CD nvarchar(2) 

PRI_HWY_NUM int 

BYPASS_CD nvarchar(2) 

MILEPOST float 

STL_ROUTE nvarchar(6) 

ADT int 

CONTROL_SECTION nvarchar(6) 

DOTD_DISTRICT nvarchar(2) 

FUNCTIONAL_CLASS nvarchar(2) 

HIGHWAY_CLASS nvarchar(1) 

LOGMILE float 

LOGMILE_FROM float 

LOGMILE_TO float 

LAT float 

LONG float 

MEDIAN_WIDTH smallint 

MILEPOINT float 

MILEPOST_FROM float 

MILEPOST_TO float 

NUM_LANES smallint 

PARISH_CD nvarchar(2) 

PAVEMENT_TYPE nvarchar(2) 

PAVEMENT_WIDTH smallint 

SECTION_LENGTH float 

HWY_TYPE_FLAG nvarchar(1) 

HWY_NUM_FLAG nvarchar(1) 

BYPASS_FLAG nvarchar(1) 

SPOTTED_BY nvarchar(1) 

DIRECTION nvarchar(1) 

SECTION_OID (FK) int 

TYPE_ACC nvarchar(1) 

URBAN_AREA nvarchar(1) 
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INTERSECTION Bit 

MILEPOINT_FROM float 

MILEPOINT_TO float 

IRS_ID nvarchar(18) 

IRS_LOGMILE float 

CRASH_YEAR smallint 

CREATE_DATE datetime 

CREATE_USER_ID int 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID Int 

 

 
HWY_SECTION 

ROUTE nvarchar(6) 

SECTION smallint 

SUBSECTION smallint 

YEAR smallint 

STATE_CODE nvarchar(2) 

FIPS_PARISH smallint 

PLACE_CODE nvarchar(5) 

SECTION_LENGTH float 

MILEPOINT_FROM float 

TRAVEL_ROUTE_CAT nvarchar(1) 

TRAVEL_ROUTE_NUM nvarchar(5) 

DOMAIN nvarchar(2) 

GOVT_LEVEL_CONTROL nvarchar(2) 

ADMIN_CLASS nvarchar(1) 

FED_AID_SYS_TRAV nvarchar(1) 

FED_AID_SYS_DESIG nvarchar(1) 

TOLLRAOD nvarchar(1) 

FED_AID_URBAN_AREA nvarchar(1) 

FUNCTIONAL_CLASS nvarchar(2) 

HIGHWAY_CLASS nvarchar(1) 

SPECIAL_SYSTEM nvarchar(2) 

MUNICIPALITY nvarchar(1) 

CENSUS_CATEGORY nvarchar(1) 

POP_GROUP nvarchar(1) 

PKWY_TRUCKS nvarchar(1) 

ACCESS_CONTROL nvarchar(1) 

ADT int 

ROW_WIDTH smallint 

SHOULDER_TYPE_PRI nvarchar(1) 

PAVEMENT_TYPE_PRI nvarchar(2) 

PAVEMENT_WIDTH_PRI smallint 

NUM_LANES smallint 

MEDIAN_TYPE nvarchar(1) 

SHOULDER_TYPE_OTH nvarchar(1) 

PAVEMENT_TYPE_OTH nvarchar(2) 

PAVEMENT_WIDTH_OTH smallint 

NO_LANES_OTH44 smallint 

NEUT_GROUND_WIDTH smallint 

OLD_FUNC_CLASS nvarchar(2) 

PROPOSED_ELIMINATE nvarchar(1) 
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SHOULDER_WIDTH_PRI smallint 

SHOULDER_WIDTH_OTH smallint 

NHS_FLAG nvarchar(1) 

NHS_SEGMENT nvarchar(3) 

CLASS_STATION nvarchar(4) 

NHS_LINK nvarchar(1) 

TRUCK_ROUTE nvarchar(1) 

ACC_ROUTE nvarchar(5) 

ACC_MILEPOST_FROM float 

ACC_MILEPOST_TO float 

CONTROL_SECTION nvarchar(6) 

LOGMILE_FROM float 

LOGMILE_TO float 

ADT_STATION_NUM nvarchar(6) 

CSECT_OPP_ROUTE nvarchar(1) 

FED_AID_STATUS nvarchar(1) 

DISTRICT nvarchar(2) 

PARISH nvarchar(2) 

URBAN_AREA_CODE nvarchar(5) 

FORMATTED_ROUTE nvarchar(9) 

OID(PK) int 

LRS_ID nvarchar(18) 

HWY_TYPE_CD nvarchar(1) 

PRI_HWY_NUM int 

BYPASS_CD nvarchar(1) 

ACC_HWY_TYPE_CD nvarchar(1) 

ACC_PRI_HWY_NUM int 

ACC_BYPASS_CD nvarchar(1) 

CSECT_DIRECTION int 

MILEPOST_DIRECTION Int 

MILEPOST_LENGTH float 

CSECT_LENGTH float 

MILEPOINT_TO float 

MAP_LENGTH float 

CREATE_DATE datetime 

CREATE_USER_ID int 

LAST_UPDATE_DATE datetime 

LAST_UPDATE_USERID int 
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APPENDIX B 

Reference Data 

 

 
REGION TYPE REGION ID 

DISTRICT 2 - 8, 58, 61, 62 

PARISH 1 - 64 

 

 

DISTRICT CODE DISTRICT NAME 

2 BRIDGE CITY 

3 LAFAYETTE 

4 SHREVEPORT 

5 MONROE 

7 LAKE CHARLES 

8 ALEXANDRIA 

58 CHASE 

61 BATON ROUGE 

62 HAMMOND 

 

 

PARISH CODE PARISH NAME DISTRICT CODE 

1 ACADIA 3 

2 ALLEN 7 

3 ASCENSION 61 

4 ASSUMPTION 61 

5 AVOYELLES 8 

6 BEAUREGARD 7 

7 BIENVILLE 4 

8 BOSSIER 4 

9 CADDO 4 

10 CALCASIEU 7 

11 CALDWELL 58 

12 CAMERON 7 

13 CATAHOULA 58 

14 CLAIBORNE 4 

15 CONCORDIA 58 

16 DESOTO 4 

17 EAST BATON ROUGE 61 

18 EAST CARROLL 5 

19 EAST FELICIANA 61 

20 EVANGELINE 3 

21 FRANKLIN 58 

22 GRANT 8 

23 IBERIA 3 

24 IBERVILLE 61 

25 JACKSON 5 
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26 JEFFERSON 2 

27 JEFFERSON DAVIS 7 

28 LAFAYETTE 3 

29 LAFOURCHE 2 

30 LASALLE 58 

31 LINCOLN 5 

32 LIVINGSTON 62 

33 MADISON 5 

34 MOREHOUSE 5 

35 NATCHITOCHES 8 

36 ORLEANS 2 

37 OUACHITA 5 

38 PLAQUEMINES 2 

39 POINTE COUPEE 61 

40 RAPIDES 8 

41 RED RIVER 4 

42 RICHLAND 5 

43 SABINE 8 

44 ST. BERNARD 2 

45 ST. CHARLES 2 

46 ST. HELENA 62 

47 ST. JAMES 61 

48 ST. JOHN 62 

49 ST. LANDRY 3 

50 ST. MARTIN 3 

51 ST. MARY 3 

52 ST. TAMMANY 62 

53 TANGIPAHOA 62 

54 TENSAS 58 

55 TERREBONNE 2 

56 UNION 5 

57 VERMILLION 3 

58 VERNON 8 

59 WASHINGTON 62 

60 WEBSTER 4 

61 WEST BATON ROUGE 61 

62 WEST CARROLL 5 

63 WEST FELICIANA 61 

64 WINN 8 

 

 

SITE TYPE SITE ID 

INTERSECTION INTERSECTION_ID 

NON-INTERSECTION LRS_ID 

CONTROL SECTION CONTROL_SECTION 

 

 

SIGN NAME SIGN CODE SIGN ICON NAME 

2 MILES (1 LINE) (ENGLISH) W16-3a Image_Not_Available_SM 

2 MILES (2 LINE) (ENGLISH) W16-3 Image_Not_Available_SM 

270 DEGREE LOOP W1-15 Image_Not_Available_SM 

4-WAY R1-3 R1-3_4-WAY_Sm 
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500 FT (1 LINE) (ENGLISH) W16-2a Image_Not_Available_SM 

500 FT (2 LINE) (ENGLISH) W16-2 Image_Not_Available_SM 

500 FT (2 LINE) (ENGLISH) W16-4 Image_Not_Available_SM 

8:30 AM TO 5:30 PM S4-1 Image_Not_Available_SM 

ACTIVATED BLANK-OUT R3-1a 
R3-1a_ADVICATED BLANK-

OUT_Sm 

ACTIVATED BLANK-OUT R3-2a Image_Not_Available_SM 

ADDED LANE W4-3L Image_Not_Available_SM 

ADDED LANE W4-3R W4-3R_ADDED LANE_SM 

ADVANCE INTERSECTION 

LANE CONTROL 
R3-8 

R3-8_Advance Intersection Lane 

Control_SM 

ADVANCE INTERSECTION 

LANE CONTROL 
R3-8a 

R3-8a_Advance Intersection Lane 

Control_SM 

ADVANCE INTERSECTION 

LANE CONTROL 
R3-8b 

R3-8b_Advance Intersection Lane 

Control_SM 

ADVANCE PARKING AREA 

DISTANCE 
D5-3 Image_Not_Available_SM 

ADVANCE REST - WELCOME 

SIGN 
D5-9 Image_Not_Available_SM 

ADVANCE REST AREA - 

TOURIST INFORMATION 

CENTER SIGN 

D5-7 Image_Not_Available_SM 

ADVANCE REST AREA 

DISTANCE 
D5-1 Image_Not_Available_SM 

ADVANCE REST AREA 

DISTANCE 
D5-1a Image_Not_Available_SM 

ADVANCE REST AREA 

DISTANCE 
D5-1b Image_Not_Available_SM 

ADVANCE REVERSIBLE 

LANE CONTROL 

TRANSITION 

R3-9g Image_Not_Available_SM 

ADVANCE REVERSIBLE 

LANE CONTROL 

TRANSITION 

R3-9h Image_Not_Available_SM 

ADVANCE STREET NAME D3-2 Image_Not_Available_SM 

ADVANCE STREET NAME 

PLAQUE 
W16-8 Image_Not_Available_SM 

ADVANCE STREET NAME 

PLAQUE 
W16-8a Image_Not_Available_SM 

ADVANCE WEIGH STATION 

DISTANCE 
D8-1 Image_Not_Available_SM 

ADVISORY CURVE SPEED 

(ENGLISH) 
W13-5 

W13-5_ADVISORY CURVE 

SPEED (ENGLISH)_SM 

ADVISORY RAMP SPEED W13-3 
W13-3_ADVISORY RAMP 

SPEED_SM 

ADVISORY SPEED (ENGLISH) W13-1 
W13-1_ADVISORY SPEED 

(ENGLISH)_SM 

ADVISORY SPEED (ENGLISH) W13-2 
W13-2_ADVISORY SPEED 

(ENGLISH)_SM 

AHEAD PLAQUE W16-9p Image_Not_Available_SM 

AIRPORT I-5 Image_Not_Available_SM 

ALL WAY R1-4 R1-4_ALL WAY_Sm 

ALTERNATE AUXILIARY M4-1 Image_Not_Available_SM 

ALTERNATE AUXILIARY M4-1a Image_Not_Available_SM 
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ALTERNATIVE FUEL D9-11a Image_Not_Available_SM 

AMBULANCE STATION D9-13b Image_Not_Available_SM 

AREA CLOSE EM-2 Image_Not_Available_SM 

ARROW PLAQUE W16-5pL Image_Not_Available_SM 

ARROW PLAQUE W16-5pR Image_Not_Available_SM 

ARROW PLAQUE W16-6pL Image_Not_Available_SM 

ARROW PLAQUE W16-6pR Image_Not_Available_SM 

AXLE WEIGHT LIMIT R12-2 Image_Not_Available_SM 

BE PREPARED TO STOP W3-4 Image_Not_Available_SM 

BEGIN AUXILIARY M4-11 Image_Not_Available_SM 

BEGIN RIGHT TURN LANE - 

YIELD TO BIKES 
R4-4 Image_Not_Available_SM 

BICYCLE DETOUR M4-9c Image_Not_Available_SM 

BICYCLE HILL PLAQUE W7-5 Image_Not_Available_SM 

BICYCLE HILL PLAQUE W7-5a Image_Not_Available_SM 

BICYCLE PARKING D4-3 Image_Not_Available_SM 

BICYCLE PEDESTRIAN 

DETOUR 
M4-9a Image_Not_Available_SM 

BICYCLE ROUTE D11-1 Image_Not_Available_SM 

BICYCLE ROUTE M1-8 Image_Not_Available_SM 

BICYCLE ROUTE M1-9 Image_Not_Available_SM 

BICYCLE SLIPPERY WHEN 

WET 
W8-10 Image_Not_Available_SM 

BICYCLE SLIPPERY WHEN 

WET PLAQUE 
W8-10a Image_Not_Available_SM 

BICYCLE TRAFFIC W11-1 W11-1_BICYCLE TRAFFIC_SM 

BICYCLE WRONG WAY R5-1b Image_Not_Available_SM 

BICYCLISTS USE THE 

PEDESTRIAN SIGNAL 
R9-5 Image_Not_Available_SM 

BICYCLISTS YIELD TO 

PEDESTRIANS 
R9-6 Image_Not_Available_SM 

BIKE ACTUATION R10-22 Image_Not_Available_SM 

BIKE LANE R3-17 Image_Not_Available_SM 

BIKE LANE AHEAD R3-17a Image_Not_Available_SM 

BIKE LANE ENDS R3-17b Image_Not_Available_SM 

BIKEWAY NARROWS W5-4a Image_Not_Available_SM 

BLASTING ZONE AHEAD W22-1 Image_Not_Available_SM 

BRAZOS RIVER I-3 Image_Not_Available_SM 

BRIDGE ICES BEFORE ROAD W8-13 
W8-13_BRIDGE ICES BEFORE 

ROAD_SM 

BUMP W8-1 W8-1_BUMP_SM 

BUS STATION I-6 Image_Not_Available_SM 

BY-PASS AUXILIARY M4-2 Image_Not_Available_SM 

BY-PASS AUXILIARY M4-3 Image_Not_Available_SM 

CAMPING D9-3 Image_Not_Available_SM 

CAR POOL INFORMATION D12-2 Image_Not_Available_SM 

CARDINAL DIRECTION 

AUXILIARY 
M3-1 Image_Not_Available_SM 

CARDINAL DIRECTION 

AUXILIARY 
M3-2 Image_Not_Available_SM 

CARDINAL DIRECTION 

AUXILIARY 
M3-3 Image_Not_Available_SM 

CARDINAL DIRECTION 

AUXILIARY 
M3-4 Image_Not_Available_SM 
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CATTLE TRAFFIC W11-4 Image_Not_Available_SM 

CENTER (RIGHT) (LEFT) 

LANE CLOSED AHEAD 
W9-3 Image_Not_Available_SM 

CENTER LANE CLOSED W9-3a Image_Not_Available_SM 

CHANNEL 9 MONITORED D12-3 Image_Not_Available_SM 

CHEMICAL SHELTER EM-7d Image_Not_Available_SM 

CHEVRON ALIGNMENT W1-8L 
W1-8L_CHEVRON 

ALIGNMENT_SM 

CHEVRON ALIGNMENT W1-8R 
W1-8R_CHEVRON 

ALIGNMENT_SM 

CIRCULAR INTERSECTION W2-6 
W2-6_CIRCULAR 

INTERSECTION_SM 

COMBINATION JUNCTION M2-2 Image_Not_Available_SM 

COMBINATION REST AREA 

STATE WELCOME CENTER 

EXIT DIRECTION 

D5-10 Image_Not_Available_SM 

COMBINATION REST AREA 

STATE WELCOME CENTER 

NEXT RIGHT 

D5-11 Image_Not_Available_SM 

COMBINATION REST AREA 

TOURIST INFO CENTER EXIT 

DIRECTION 

D5-8 Image_Not_Available_SM 

COMBINED SPEED LIMIT 

(ENGLISH) 
R2-4a 

R2-4a_COMBINED SPEED 

LIMIT (ENGLISH)_Sm 

COMINATION U-TURN & 

LEFT TURN PROHIBITION 
R3-18 

R3-18_Combiniation U-Turn & 

Left Turn Prohibition_SM 

COMMERCIAL VEHICLES 

EXCLUDED 
R5-4 Image_Not_Available_SM 

COUNTY ROUTE M1-6 Image_Not_Available_SM 

CROSS ON GREEN LIGHT 

ONLY 
R10-1 Image_Not_Available_SM 

CROSS ONLY AT CROSS 

WALKS 
R9-2 Image_Not_Available_SM 

CROSS ONLY ON WALK 

SIGNAL 
R10-2a Image_Not_Available_SM 

CROSS ROAD W2-1 W2-1_CROSS ROAD_SM 

CROSSOVER D13-1 Image_Not_Available_SM 

CROSSOVER D13-2 Image_Not_Available_SM 

CURVE W1-2 Image_Not_Available_SM 

CURVE (ENGLISH) W1-2a L Image_Not_Available_SM 

CURVE (ENGLISH) W1-2a R Image_Not_Available_SM 

DEAD END W14-1 W14-1_DEAD END_SM 

DEAD END W14-1aL Image_Not_Available_SM 

DEAD END W14-1aR Image_Not_Available_SM 

DECONTAMINATION 

CENTER EM-6d 
Image_Not_Available_SM 

DEER TRAFFIC W11-3 Image_Not_Available_SM 

DESTINATION D1-1 Image_Not_Available_SM 

DESTINATION D1-1a Image_Not_Available_SM 

DESTINATION D1-1bL Image_Not_Available_SM 

DESTINATION D1-1bR Image_Not_Available_SM 

DESTINATION D1-1c Image_Not_Available_SM 

DESTINATION D1-2 Image_Not_Available_SM 

DESTINATION D1-2a Image_Not_Available_SM 
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DESTINATION D1-3 Image_Not_Available_SM 

DESTINATION D1-3a Image_Not_Available_SM 

DETOUR M4-8 Image_Not_Available_SM 

DETOUR M4-9L Image_Not_Available_SM 

DETOUR M4-9R Image_Not_Available_SM 

DETOUR W20-2 Image_Not_Available_SM 

DETOUR (INSIDE ARROW) M4-10L Image_Not_Available_SM 

DETOUR (INSIDE ARROW) M4-10R Image_Not_Available_SM 

DIESEL FUEL D9-11 Image_Not_Available_SM 

DIP W8-2 W8-2_DIP_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M5-1 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M5-2 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-1 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-2 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-3 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-4 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-5 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-6 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-7 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-8 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY 
M6-9 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-1 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-2 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-3 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-4 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-5 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-6 Image_Not_Available_SM 

DIRECTIONAL ARROW 

AUXILIARY (BICYCLE 

FACILITIES) 

M7-7 Image_Not_Available_SM 

DISTANCE D2-1 Image_Not_Available_SM 

DISTANCE D2-2 Image_Not_Available_SM 
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DISTANCE D2-3 Image_Not_Available_SM 

DIVIDED HIGHWAY W6-1 W6-1_DIVIDED HIGHWAY_SM 

DIVIDED HIGHWAY W6-1a 
 

DIVIDED HIGHWAY 

CROSSING 
R6-3 

R6-3_DIVIDED HIGHWAY 

CROSSING_SM 

DIVIDED HIGHWAY 

CROSSING 
R6-3a Image_Not_Available_SM 

DIVIDED HIGHWAY ENDS W6-2 Image_Not_Available_SM 

DIVIDED HIGHWAY ENDS W6-2a Image_Not_Available_SM 

DIVIDED ROAD W6-1b Image_Not_Available_SM 

DIVIDED ROAD ENDS W6-2b Image_Not_Available_SM 

DO NOT BLOCK 

INTERSECTION 
R10-7 

R10-7_DO NOT BLOCK 

INTERSECTION_SM 

DO NOT DRIVE ON TRACKS R15-6a Image_Not_Available_SM 

DO NOT DRIVE ON TRACKS 

LIGHT RAIL SYMBOL 
R15-6 Image_Not_Available_SM 

DO NOT ENTER R5-1 R5-1_DO NOT ENTER_SM 

DO NOT PASS R4-1 R4-1_Do Not Pass_SM 

DO NOT PASS STOPPED 

TRAIN 
R15-5a Image_Not_Available_SM 

DO NOT STOP ON TRACKS R8-8 
R8-8_DO NOT STOP ON 

TRACKS_SM 

DOUBEL REVERSE CURVE (2 

LANES) 
W24-1aL Image_Not_Available_SM 

DOUBEL REVERSE CURVE (2 

LANES) 
W24-1aR Image_Not_Available_SM 

DOUBLE ARROW W12-1 W12-1_DOUBLE ARROW_SM 

DOUBLE REVERSE CURVE (1 

LANE) 
W24-1L Image_Not_Available_SM 

DOUBLE REVERSE CURVE (1 

LANE) 
W24-1R Image_Not_Available_SM 

DOUBLE REVERSE CURVE (3 

LANES) 
W24-1bL Image_Not_Available_SM 

DOUBLE REVERSE CURVE (3 

LANES) 
W24-1bR Image_Not_Available_SM 

DRAW BRIDGE AHEAD W3-6 Image_Not_Available_SM 

EMERGENCY DIAL 911 D12-4 Image_Not_Available_SM 

EMERGENCY MEDICAL 

CARE 
D9-13c Image_Not_Available_SM 

EMERGENCY MEDICAL 

SERVICES 
D9-13 Image_Not_Available_SM 

EMERGENCY NOTIFICATION I-13 Image_Not_Available_SM 

EMERGENCY NOTIFICATION I-13a Image_Not_Available_SM 

EMERGENCY PARKING 

ONLY 
R8-4 

R8-4_EMERGENCY PARKING 

ONLY_SM 

EMERGENCY SHELTER EM-7a Image_Not_Available_SM 

EMERGENCY SIGNAL R10-13 
R10-13_EMERGENCY 

SIGNAL_SM 

EMERGENCY SIGNAL 

AHEAD 
W11-12p Image_Not_Available_SM 

EMERGENCY SNOW ROUTE R7-203 Image_Not_Available_SM 

EMERGENCY STOPPING 

ONLY 
R8-7 

R8-7_EMERGENCY STOPPING 

ONLY_SM 

EMERGENCY VEHICLE W11-8 Image_Not_Available_SM 
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END M4-8b Image_Not_Available_SM 

END AUXILIARY M4-12 Image_Not_Available_SM 

END AUXILIARY M4-6 Image_Not_Available_SM 

END BLASTING ZONE W22-3 Image_Not_Available_SM 

END DETOUR M4-8a Image_Not_Available_SM 

END REVERSE LANE R3-9i Image_Not_Available_SM 

END ROAD WORK G20-2 Image_Not_Available_SM 

END SCHOOL ZONE S5-2 Image_Not_Available_SM 

ENHANCED REFERENCE 

LOCATION SIGNS 
D10-4 Image_Not_Available_SM 

ENTERING ROADWAY LANE 

ADDED 
W4-6 Image_Not_Available_SM 

ENTERING ROADWAY 

MERGE 
W4-5 

W4-5_ENTERING ROADWAY 

MERGE_SM 

EQUESTRIAN TRAFFIC W11-7 Image_Not_Available_SM 

EXAMPLES OF DESIGN 

APPLICATIONS 

RECREATIONAL & 

CULTURAL INTEREST SIGNS 

RM-140 Image_Not_Available_SM 

EXEMPT R15-3/10-1a Image_Not_Available_SM 

EXIT CLOSED E5-2a Image_Not_Available_SM 

EXIT ONLY E5-3 Image_Not_Available_SM 

EXIT OPEN E5-2 Image_Not_Available_SM 

FALLOUT SHELTER EM-7c Image_Not_Available_SM 

FARM MACHINERY TRAFFIC W11-5 Image_Not_Available_SM 

FARM MACHINERY TRAFFIC W11-5a Image_Not_Available_SM 

FINES HIGHER R2-6 R2-6_FINES HIGHER_Sm 

FLAGGER W20-7 Image_Not_Available_SM 

FLAGGER W20-7a Image_Not_Available_SM 

FOOD D9-8 Image_Not_Available_SM 

FOREST ROUTE M1-7 Image_Not_Available_SM 

FREEWAY ENTRANCE D13-3 Image_Not_Available_SM 

FREEWAY ENTRANCE D13-3aL Image_Not_Available_SM 

FREEWAY ENTRANCE D13-3aR Image_Not_Available_SM 

FRESH OIL (TAR) W21-2 Image_Not_Available_SM 

GAS D9-7 Image_Not_Available_SM 

GOLF CART TRAFFIC W11-11 Image_Not_Available_SM 

HAIRPIN CURVE W1-11 Image_Not_Available_SM 

HANDICAMPT W11-9 Image_Not_Available_SM 

HANDICAPPED ACCESSIBLE D9-6 Image_Not_Available_SM 

HAZARDOUS MATERIAL R14-2 Image_Not_Available_SM 

HAZARDOUS MATERIAL R14-3 Image_Not_Available_SM 

HIGHWAY RAIL GRADE 

CROSSING (CROSS BUCK) 
R15-1 

R15-1_HIGHWAY RAIL GRADE 

CROSSING (CROSS BUCK)_SM 

HIGHWAY-RAIL GRADE 

CROSSING ADVANCE 

WARNING 

W10-1 

W10-1_HIGHWAY-RAIL 

GRADE CROSSING ADVANCE 

WARNING_SM 

HIGHWAY-RAIL GRADE 

CROSSING ADVANCE 

WARNING 

W10-2L Image_Not_Available_SM 

HIGHWAY-RAIL GRADE 

CROSSING ADVANCE 

WARNING 

W10-2R Image_Not_Available_SM 

HIGHWAY-RAIL GRADE W10-3L Image_Not_Available_SM 
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CROSSING ADVANCE 

WARNING 

HIGHWAY-RAIL GRADE 

CROSSING ADVANCE 

WARNING 

W10-3R Image_Not_Available_SM 

HIGHWAY-RAIL GRADE 

CROSSING ADVANCE 

WARNING 

W10-4L Image_Not_Available_SM 

HIGHWAY-RAIL GRADE 

CROSSING ADVANCE 

WARNING 

W10-4R Image_Not_Available_SM 

HILL W7-1 W7-1_HILL_SM 

HILL W7-1a Image_Not_Available_SM 

HILL W7-1b Image_Not_Available_SM 

HILL BLOCKS VIEW W7-6 Image_Not_Available_SM 

HILL PLAQUE W7-2 Image_Not_Available_SM 

HILL PLAQUE W7-2b Image_Not_Available_SM 

HILL PLAQUE W7-3 Image_Not_Available_SM 

HILL PLAQUE W7-3a Image_Not_Available_SM 

HILL PLAQUE W7-3b Image_Not_Available_SM 

HITCH HIKING PROHIBITED R9-4a Image_Not_Available_SM 

HORIZONTAL ALIGNMENT W1-10L Image_Not_Available_SM 

HORIZONTAL ALIGNMENT W1-10R Image_Not_Available_SM 

HORSE AND BUGGY 

TRAFFIC 
W11-14 Image_Not_Available_SM 

HOSPITAL D9-13a` Image_Not_Available_SM 

HOSPITAL D9-2 Image_Not_Available_SM 

HOV W16-11 Image_Not_Available_SM 

HOV LANE AHEAD 

(OVERHEAD) 
R3-15 Image_Not_Available_SM 

HOV LANE AHEAD 

(OVERHEAD) 
R3-15a Image_Not_Available_SM 

HURRICANE EVACUATION 

ROUTE EM-1 
Image_Not_Available_SM 

HURRICANE SHELTER EM-7b Image_Not_Available_SM 

IN-STREET PEDESTRIAN 

CROSSING 
R1-6 

R1-6_IN-STREET PEDESTRIAN 

CROSSING_Sm 

IN-STREET PEDESTRIAN 

CROSSING 
R1-6a 

R1-6a_IN-STREET 

PEDESTRIAN CROSSING_Sm 

INTERMEDIATE ENHANCED 

REFERENCE LOCATION 
D10-5 Image_Not_Available_SM 

INTERMEDIATE REFERENCE 

LOCATION SIGNS 
D10-1a Image_Not_Available_SM 

INTERMEDIATE REFERENCE 

LOCATION SIGNS 
D10-2a Image_Not_Available_SM 

INTERMEDIATE REFERENCE 

LOCATION SIGNS 
D10-3a Image_Not_Available_SM 

INTERSTATE ROUTE (1,2 

DIGITS) 
M1-1 

M1-1_INTERSTATE 

ROUTE_SM 

JUNCTION AUXILIARY M2-1 Image_Not_Available_SM 

KEEP LEFT R4-8 R4-8_KEEP LEFT_SM 

KEEP LEFT/RIGHT TO 

PEDESTRIANS AND 

BICYCLISTS 

R9-7 

R9-7_KEEP LEFT-RIGHT TO 

PEDESTRIANS AND 

BICYCLES_SM 
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KEEP OFF MEDIAN R11-1 R11-1_KEEP OFF MEDIAN_SM 

KEEP RIGHT R4-7 R4-7_Keep Rights-SM 

KEEP RIGHT R4-7a R4-7a_Keep Right_SM 

KEEP RIGHT R4-7b R4-7b_KEEP RIGHT_SM 

LANE ENDS W4-2L Image_Not_Available_SM 

LANE ENDS W4-2R Image_Not_Available_SM 

LANE ENDS MERGE LEFT 

(RIGHT) 
W9-2 

W9-2L_LANE ENDS MERGE 

LEFT (RIGHT)_SM 

LEFT (RIGHT) TURN SIGNAL R10-10L 
R10-10L_LEFT-RIGHT TURN 

SIGNAL_SM 

LEFT (RIGHT) TURN SIGNAL R10-10R Image_Not_Available_SM 

LEFT DIAGONAL ARROW 

PLAQUE 
W16-7pL Image_Not_Available_SM 

LEFT DIAGONAL ARROW 

PLAQUE 
W16-7pR Image_Not_Available_SM 

LEFT ON GREEN ARROW 

ONLY 
R10-5 Image_Not_Available_SM 

LEFT SHOULDER CLOSED W21-5aL Image_Not_Available_SM 

LEFT SHOULDER CLOSED W21-5bL Image_Not_Available_SM 

LEFT TURN PROHIBITION R3-2 Image_Not_Available_SM 

LEFT TURN SIGNAL YIELD 

ON GREEN 
R10-21 Image_Not_Available_SM 

LEFT TURN YIELD ON 

GREEN 
R10-12 

R10-12_LEFT TURN YIELD ON 

GREEN_SM 

LIBRARY I-8 Image_Not_Available_SM 

LIBRARY I-8p Image_Not_Available_SM 

LIGHT RAIL ACTIVATED 

BLANK-OUT SYMBOL 
W10-7 Image_Not_Available_SM 

LIGHT RAIL DIVIDED 

HIGHWAY SYMBOL 
R15-7 

R15-7_LIGHT RAIL DIVIDED 

HIGHWAY SYMBOL_SM 

LIGHT RAIL DIVIDED 

HIGHWAY SYMBOL 
R15-7a Image_Not_Available_SM 

LIGHT RAIL DO NOT PASS R15-5 Image_Not_Available_SM 

LIGHT RAIL ONLY CENTER 

LANE 
R15-4c Image_Not_Available_SM 

LIGHT RAIL ONLY LEFT 

LANE 
R15-4b Image_Not_Available_SM 

LIGHT RAIL ONLY RIGHT 

LANE 
R15-4a Image_Not_Available_SM 

LIGHT RAIL STATION I-12 Image_Not_Available_SM 

LITTER CONTAINER D9-4 Image_Not_Available_SM 

LODGING D9-9 Image_Not_Available_SM 

LOOK R15-8 Image_Not_Available_SM 

LOOSE GRAVEL W8-7 Image_Not_Available_SM 

LOOSE GRAVEL W8-8 Image_Not_Available_SM 

LOW CLEARANCE (ENGLISH) W12-2 
W12-2_LOW CLEARANCE 

(ENGLISH)_SM 

LOW CLEARANCE (ENGLISH) W12-2p Image_Not_Available_SM 

LOW GROUND CLEARANCE 

HIGHWAY-RAIL GRADE 

CROSSING 

W10-5 Image_Not_Available_SM 

LOW SHOULDER W8-9 W8-9_LOW SHOULDER_SM 

MAINTAIN TOP SAFE SPEED EM-4 Image_Not_Available_SM 

MANDATORY MOVEMENT R3-5a R3-5a_MADATORY 
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LANE CONTROL MOVEMENT LANE 

CONTROL_Sm 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5b R3-5b Lane Control Plaques_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5c Image_Not_Available_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5d Image_Not_Available_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5e Image_Not_Available_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5f R3-5F Lane Control Plaques_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5g Image_Not_Available_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5L 

R3-5L_MANDATORY 

MOVEMENT LANE 

CONTROL_Sm 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-5R 

R3-5R_MANDATORY 

MOVEMENT LANE 

CONTROL_Sm 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-7L 

R3-7L_Mandatory Movement 

Land Control_SM 

MANDATORY MOVEMENT 

LANE CONTROL 
R3-7R 

R3-7R_Mandatory Movement 

Lane Control_SM 

MEDICAL CENTER EM-6a Image_Not_Available_SM 

MERGE W4-1L Image_Not_Available_SM 

MERGE W4-1R W4-1R_MERGE_SM 

METRIC R12-6 Image_Not_Available_SM 

MINIMUM SPEED (ENGLISH) R2-4 
R2-4_MINIMUM SPEED 

LMIT(ENGLISH)_Sm 

MON-FRI S4-6 Image_Not_Available_SM 

MON-FRI (3 LINES) R10-20a Image_Not_Available_SM 

MOTOR-DRIVEN CYCLES 

PROHIBITED 
R5-8 Image_Not_Available_SM 

MOTORIST SERVICES SIGN D9-18 Image_Not_Available_SM 

MOTORIST SERVICES SIGN D9-18a Image_Not_Available_SM 

MOTORIST SERVICES SIGN D9-18b Image_Not_Available_SM 

MOTORIST SERVICES SIGN D9-18c Image_Not_Available_SM 

MOTORIST SERVICES SIGN D9-18e Image_Not_Available_SM 

MOTORIST SERVICES SIGN E2-2 Image_Not_Available_SM 

MOTORIST SERVICES 

SYMBOL SIGN 
E1-5 Image_Not_Available_SM 

MOTORIST SERVICES 

SYMBOL SIGN 
E2-3 Image_Not_Available_SM 

NARROW BRIDGE W5-2 Image_Not_Available_SM 

NATIONAL NETWORK R14-4 Image_Not_Available_SM 

NATIONAL NETWORK 

PROHIBITED 
R14-5 Image_Not_Available_SM 

NATIONAL PARK D7-1 Image_Not_Available_SM 

NATIONAL PARK ARROW D7-2 Image_Not_Available_SM 

NEXT CROSSING W10-14 Image_Not_Available_SM 

NEXT REST AREA (XX 

MILES) 
D5-6 Image_Not_Available_SM 

NEXT SERVICES XX MILES D9-17 Image_Not_Available_SM 
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(ENGLISH) 

NIGHT SPEED LIMIT 

(ENGLISH) 
R2-3 

R2-3_NIGHT SPEED LIMIT 

(ENGLISH)_Sm 

NO BICYCLES R5-6 R5-6_NO BICYCLES_SM 

NO CENTER STRIPE W8-12 Image_Not_Available_SM 

NO GATES OR LIGHTS W10-13 Image_Not_Available_SM 

NO HITCH HIKING R9-4 Image_Not_Available_SM 

NO MOTOR VEHICLES R5-3 
R5-3_NO MOTOR 

VEHICLES_SM 

NO OUTLET W14-2 W14-2_NO OUTLET_SM 

NO OUTLET W14-2aL Image_Not_Available_SM 

NO OUTLET W14-2aR Image_Not_Available_SM 

NO PARKING R7-1 R7-1_NO PARKING_SM 

NO PARKING R7-107 R7-107_NO PARKING_SM 

NO PARKING R7-2 R7-2_NO PARKING_SM 

NO PARKING R7-2a R7-2a_NO PARKING_SM 

NO PARKING R7-3 Image_Not_Available_SM 

NO PARKING R7-4 Image_Not_Available_SM 

NO PARKING R7-5 Image_Not_Available_SM 

NO PARKING R7-6 R7-6_NO PARKING_SM 

NO PARKING R7-7 R7-7_NO PARKING_SM 

NO PARKING R7-8 Image_Not_Available_SM 

NO PARKING R8-3 R8-3_NO PARKING_SM 

NO PARKING (SYMBOL) R8-3a 
R8-3a_NO PARKING 

(SYMBOL)_SM 

NO PARKING (WITH 

TRANSIT LOGO) 
R7-107a 

R7-107a_NO PARKING (WITH 

TRANSIT LOGO)_SM 

NO PARKING EXCEPT ON 

SHOULDER 
R8-2 Image_Not_Available_SM 

NO PARKING ON PAVEMENT R8-1 Image_Not_Available_SM 

NO PARKING PLAQUE R8-3c Image_Not_Available_SM 

NO PARKING PLAQUE R8-3d Image_Not_Available_SM 

NO PARKING, BIKE LANE R7-9 
R7-9_NO PARKING, BIKE 

LANE_SM 

NO PARKING, BIKE LANE R7-9a 
R7-9a_NO PARKING, BIKE 

LANE_SM 

NO PARKING/RESTRICTED 

PARKING (COMBINED SIGN) 
R7-200 Image_Not_Available_SM 

NO PARKING-TIME R7-108 
R7-108_NO PARKING-

TIME_SM 

NO PASSING ZONE W14-3 W14-3_NO PASSING ZONE_SM 

NO PEDESTRIAN CROSSING R9-3 
R9-3_NO PEDESTRIAN 

CROSSING_SM 

NO PEDESTRIAN CROSSING R9-3a 
R9-3a_NO PEDESTRIAN 

CROSSING_SM 

NO SIGNAL W10-10 Image_Not_Available_SM 

NO STOPPING EXCEPT ON 

SHOULDER 
R8-6 Image_Not_Available_SM 

NO STOPPING ON 

PAVEMENT 
R8-5 Image_Not_Available_SM 

NO TRAFFIC SIGNS W18-1 Image_Not_Available_SM 

NO TRAIN HORN W10-9 Image_Not_Available_SM 
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NO TRUCKS R5-2 R5-2_NO TRUCKS_SM 

NO TRUCKS R5-2a R5-2a_NO TRUCKS_SM 

NO TURN ON RED R10-11 Image_Not_Available_SM 

NO TURN ON RED R10-11a 
R10-11a_NO TURN ON 

RED_SM 

NO TURN ON RED R10-11b 
R10-11b_NO TURN ON 

RED_SM 

NO TURNS R3-3 R3-3_NO TURNS_Sm 

NON-MOTORIZED TRAFFIC 

PROHIBITED 
R5-7 

R5-7_NON-MOTORIZED 

TRAFFIC PROHIBITED_SM 

NUMBER OF TRACKS R15-2 Image_Not_Available_SM 

OFF-INTERSTATE BUSINESS 

ROUTE (LOOP) (1,2 DIGITS) 
M1-2 Image_Not_Available_SM 

OFF-INTERSTATE BUSINESS 

ROUTE (SPUR) (1,2 DIGITS) 
M1-3 Image_Not_Available_SM 

ON RAMP W13-4 Image_Not_Available_SM 

ONCOMING TRAFFIC HAS 

EXTENDED GREEN 
W25-1 Image_Not_Available_SM 

ONCOMING TRAFFIC HAS 

EXTENDED GREEN 
W25-2 Image_Not_Available_SM 

ONE DIRECTION LARGE 

ARROW 
W1-6L Image_Not_Available_SM 

ONE DIRECTION LARGE 

ARROW 
W1-6R 

W1-6R_ONE DIRECTION 

LARGE ARROW_SM 

ONE LANE BRIDGE W5-3 W5-3_ONE LANE BRIDGE_SM 

ONE LANE ROAD W20-4 Image_Not_Available_SM 

ONE WAY R6-1L R6-1L_ONE WAY_SM 

ONE WAY R6-1R R6-1R_ONE WAY_SM 

ONE WAY R6-2R R6-2R_ONE WAY_SM 

OPTIONAL MOVEMENT 

LANE CONTROL 
R3-6L 

R3-6L_OPTIONAL MOVEMENT 

LANE CONTROL_Sm 

OPTIONAL MOVEMENT 

LANE CONTROL 
R3-6R 

R3-6R_OPTIONAL MOVEMENT 

LANE CONTROL_Sm 

PARK AND RIDE D4-2 Image_Not_Available_SM 

PARKING AREA D4-1 Image_Not_Available_SM 

PARKING AREA ARROW & 

DISTANCE 
D5-3c Image_Not_Available_SM 

PARKING AREA EXIT 

DIRECTION 
D5-4 Image_Not_Available_SM 

PARKING PLAQUE R8-3b Image_Not_Available_SM 

PASS WITH CARE R4-2 R4-2_Pass With Care_SM 

PAVEMENT ENDS W8-3 Image_Not_Available_SM 

PEDESTRIAN CROSSWALK R9-8 Image_Not_Available_SM 

PEDESTRIAN DETOUR M4-9b Image_Not_Available_SM 

PEDESTRIAN TRAFFIC W11-2 
W11-2_PEDESTRIAN 

TRAFFIC_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-3 Image_Not_Available_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-3a Image_Not_Available_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-3b Image_Not_Available_SM 

PEDESTRIAN TRAFFIC R10-3c Image_Not_Available_SM 
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SIGNAL 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-3d Image_Not_Available_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-3e Image_Not_Available_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-4 Image_Not_Available_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-4a Image_Not_Available_SM 

PEDESTRIAN TRAFFIC 

SIGNAL 
R10-4b Image_Not_Available_SM 

PEDESTRIANS AND 

BICYCLES PROHIBITED 
R5-10b Image_Not_Available_SM 

PEDESTRIANS BICYCLES 

MOTOR-DRIVEN CYCLES 

PROHIBITED 

R5-10a Image_Not_Available_SM 

PEDESTRIANS PROHIBITED R5-10c Image_Not_Available_SM 

PHOTO ENFORCED R10-19 Image_Not_Available_SM 

PHOTO ENFORCED W16-10 Image_Not_Available_SM 

PICNIC AREA D5-5c Image_Not_Available_SM 

PILOT CAR FOLLOW ME G20-4 Image_Not_Available_SM 

PLAYGROUND W15-1 Image_Not_Available_SM 

POLICE D9-14 Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

AHEAD (GROUND 

MOUNTED) 

R3-10 Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

AHEAD (GROUND 

MOUNTED) 

R3-10a 
R3-10a_Preferential Only Lane 

Ahead (Ground Mounted)_SM 

PREFERENTIAL ONLY LANE 

AHEAD (GROUND 

MOUNTED) 

R3-10b Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

AHEAD (OVERHEAD) 
R3-13 Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

AHEAD (OVERHEAD) 
R3-13a Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

ENDS (GROUND MOUNTED) 
R3-12 Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

ENDS (GROUND MOUNTED) 
R3-12a Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

ENDS (GROUND MOUNTED) 
R3-12b Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

OPERATION 
R3-11 Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

OPERATION (GROUND 

MOUNTED) 

R3-11a Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

OPERATION (GROUND 

MOUNTED) 

R3-11b Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

OPERATION (GROUND 

MOUNTED) 

R3-11c Image_Not_Available_SM 
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PREFERENTIAL ONLY LANE 

OPERATION (OVERHEAD) 
R3-14 Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

OPERATION (OVERHEAD) 
R3-14a Image_Not_Available_SM 

PREFERENTIAL ONLY LANE 

OPERATION (OVERHEAD) 
R3-14b Image_Not_Available_SM 

PROPANE GAS D9-15 Image_Not_Available_SM 

RAMP NARROWS W5-4 Image_Not_Available_SM 

RAODSIDE PARK DISTANCE D5-5d Image_Not_Available_SM 

RECYCLING I-11 Image_Not_Available_SM 

REDUCED SPPED (SCHOOL) 

ZONE AHEAD S4-5 
Image_Not_Available_SM 

REDUCED SPPED (SCHOOL) 

ZONE AHEAD S4-5a 
Image_Not_Available_SM 

REFERENCE LOCATION 

SIGNS 
D10-1 Image_Not_Available_SM 

REFERENCE LOCATION 

SIGNS 
D10-2 Image_Not_Available_SM 

REFERENCE LOCATION 

SIGNS 
D10-3 Image_Not_Available_SM 

REGISTRATION CENTER EM-6c Image_Not_Available_SM 

REST AREA EXIT DIRECTION D5-2 Image_Not_Available_SM 

REST AREA EXIT DIRECTION D5-2a Image_Not_Available_SM 

REST AREA GORE SIGN D5-2b Image_Not_Available_SM 

REVERSE CURVE W1-4L Image_Not_Available_SM 

REVERSE CURVE W1-4R W1-4R_RESERVE CURVE_SM 

REVERSE TURN W1-3L Image_Not_Available_SM 

REVERSE TURN W1-3R Image_Not_Available_SM 

REVERSIBLE LANE 

CONTROL 
R3-9d Image_Not_Available_SM 

REVERSIBLE LANE 

CONTROL 
R3-9f Image_Not_Available_SM 

RIDE WITH TRAFFIC R9-3c Image_Not_Available_SM 

RIGHT (CENTER) (LEFT) 

LANE CLOSED 
W20-5 Image_Not_Available_SM 

RIGHT (LEFT) LANE ENDS W9-1 
W9-1_RIGHT(LEFT) LANE 

ENDS_SM 

RIGHT ON RED ARROW 

AFTER STOP 
R10-17a Image_Not_Available_SM 

RIGHT SHOULDER CLOSED W21-5aR Image_Not_Available_SM 

RIGHT SHOULDER CLOSED W21-5bR Image_Not_Available_SM 

RIGHT TURN PROHIBITION R3-1 
R3-1_RIGHT TURN 

PROHIBITION_Sm 

RIGHT TWO LANES CLOSED W20-5a Image_Not_Available_SM 

ROAD CLOSED R11-2 R11-2_ROAD CLOSED_SM 

ROAD CLOSED W20-3 Image_Not_Available_SM 

ROAD CLOSED - LOCAL 

TRAFFIC ONLY 
R11-3a Image_Not_Available_SM 

ROAD CLOSED - LOCAL 

TRAFFIC ONLY 
R11-3b Image_Not_Available_SM 

ROAD CLOSED TO THRU 

TRAFFIC 
R11-4 

R11-4_ROAD CLOSED TO 

THRU TRAFFIC_SM 

ROAD MACHINERY W21-3 
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ROAD NARROWS W5-1 W5-1_ROAD NARROWS_SM 

ROAD USE PERMIT 

REQUIRED FOR THRU 

TRAFFIC EM-5 

Image_Not_Available_SM 

ROAD WORK W20-1 Image_Not_Available_SM 

ROAD WORK NEXT 5 MILES G20-1 Image_Not_Available_SM 

ROADSIDE PARK ARROW D5-5b Image_Not_Available_SM 

ROUGH CROSSING W10-15 Image_Not_Available_SM 

RUNAWAY VEHICLES ONLY R4-10 Image_Not_Available_SM 

RV SANITARY STATION D9-12 Image_Not_Available_SM 

SCENIC AREA ARROW D6-1 Image_Not_Available_SM 

SCENIC AREA EXIT 

DIRECTION 
D6-3 Image_Not_Available_SM 

SCENIC OVERLOOK 

DISTANCE 
D6-2 Image_Not_Available_SM 

SCHOOL S1-1 Image_Not_Available_SM 

SCHOOL S4-3 Image_Not_Available_SM 

SCHOOL BUS STOP AHEAD S3-1 Image_Not_Available_SM 

SCHOOL SPEED LIMIT 

(WHEN FLASHING) 

(ENGLISH) S5-1 

Image_Not_Available_SM 

SEATBELT R16-1 R16-1_SEATBELT_SM 

SHARE THE ROAD W16-1 Image_Not_Available_SM 

SHOULDER DROP OFF W8-9a Image_Not_Available_SM 

SHOULDER WORK W21-5 Image_Not_Available_SM 

SIDE ROAD W2-2L Image_Not_Available_SM 

SIDE ROAD W2-2R W2-2R_SIDE ROAD_SM 

SIDEWALK CLOSED R9-9 Image_Not_Available_SM 

SIDEWALK CLOSED AHEAD 

CROSS HERE 
R9-11 Image_Not_Available_SM 

SIDEWALK CLOSED CROSS 

HERE 
R9-11a 

R9-11a_SIDEWALK CLOSED 

CROSS HERE_SM 

SIDEWALK CLOSED USE 

OTHER SIDE 
R9-10 Image_Not_Available_SM 

SIGNAL AHEAD W3-3 W3-3_SIGNAL AHEAD_SM 

SIGNAL AHEAD W3-3a W3-3a_SIGNAL AHEAD_SM 

SKEWED CROSSING W10-12 Image_Not_Available_SM 

SLIPPERY WHEN WET W8-5 
W8-5_SLIPPERY WHEN 

WET_SM 

SLOW TRAFFIC AHEAD W23-1 Image_Not_Available_SM 

SLOWER TRAFFIC KEEP 

RIGHT 
R4-3 

R4-3_Slower Traffic Keep 

Right_SM 

SNOWMOBILE TRAFFIC W11-6 Image_Not_Available_SM 

SOFT SHOULDER W8-4 Image_Not_Available_SM 

SPEED HUMP W17-1 W17-1_SPEED HUMP_SM 

SPEED LIMIT (ENGLISH) R2-1 
R2-1_SPEED LIMIT 

(ENGLISH)_Sm 

SPEED REDUCTION W3-5 W3-5_SPEED REDUCTION_SM 

STATE LINE I-2 Image_Not_Available_SM 

STATE ROUTE (1,2 DIGITS) M1-5 Image_Not_Available_SM 

STAY IN LANE R4-9 R4-9_STAY IN LANE_SM 

STOP R1-1 R1-1_STOP_Sm 
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STOP AHEAD W3-1 W3-1_STOP AHEAD_SM 

STOP AHEAD W3-1a W3-1a_STOP AHEAD_SM 

STOP HERE ON RED R10-6 R10-6_STOP HERE ON RED_SM 

STOP HERE ON RED R10-6a Image_Not_Available_SM 

STOP HERE WHEN FLASHING R8-10 
R8-10_STOP HERE WHEN 

FLASHING_SM 

STORAGE SPACE SYMBOL W10-11 Image_Not_Available_SM 

STORAGE SPACE XX FEET 

(ENGLISH) 
W10-11a Image_Not_Available_SM 

STORAGE SPACE XX FEET 

(ENGLISH) 
W10-11b Image_Not_Available_SM 

STREET NAME D-3 Image_Not_Available_SM 

SURVEY CREW W21-6 Image_Not_Available_SM 

TELEPHONE D9-1 Image_Not_Available_SM 

TELEPHONE D9-1a Image_Not_Available_SM 

TELEPHONE D9-1b Image_Not_Available_SM 

TEMPORARY AUXILIARY 

(INTERSTATE) 
M4-7 Image_Not_Available_SM 

TEMPORARY AUXILIARY 

(INTERSTATE) 
M4-7a Image_Not_Available_SM 

THIS SIDE OF SIGN R7-202 Image_Not_Available_SM 

THREE LANE REVERSE 

CURVE 
W1-4cL Image_Not_Available_SM 

THREE LANE REVERSE 

CURVE 
W1-4cR Image_Not_Available_SM 

THRU TRAFFIC MERGE LEFT W4-7 
W4-7_THRU TRAFFIC MERGE 

LEFT_SM 

TO AUXILIARY M4-13 Image_Not_Available_SM 

TO AUXILIARY M4-5 Image_Not_Available_SM 

TO ONCOMING TRAFFIC R1-2a 
R1-2a_TO ONCOMING 

TRAFFIC_Sm 

TOURIST INFO CENTER D5-7a Image_Not_Available_SM 

TOURIST INFORMATION D9-10 Image_Not_Available_SM 

TOW AWAY ZONE R7-201 Image_Not_Available_SM 

TOW AWAY ZONE R7-201a Image_Not_Available_SM 

TRACKS OUT OF SERVICE R8-9 Image_Not_Available_SM 

TRAFFIC CIRCLE PLAQUE W16-12p Image_Not_Available_SM 

TRAFFIC CONTROL POINT EM-3 Image_Not_Available_SM 

TRAFFIC DOES NOT STOP W4-4a Image_Not_Available_SM 

TRAFFIC DOES NOT STOP W4-4b Image_Not_Available_SM 

TRAFFIC DOES NOT STOP W4-4p Image_Not_Available_SM 

TRAFFIC LAWS PHOTO 

ENFORCED 
R10-18 

R10-18_TRAFFIC LAWS 

PHOTO ENFORCED_SM 

TRAFFIC SIGNAL SPEED I1-1 Image_Not_Available_SM 

TRAILER CAMPING D9-3a Image_Not_Available_SM 

TRAIN STATION I-7 Image_Not_Available_SM 

TRAINS MAY EXCEED XX 

MPH 
W10-8 Image_Not_Available_SM 

TRAVEL INFO CALL 511 D12-5 Image_Not_Available_SM 

TRUCK AUXILIARY M4-4 Image_Not_Available_SM 

TRUCK CROSSING W11-10 Image_Not_Available_SM 

TRUCK CROSSING W8-6 Image_Not_Available_SM 



  

58 

 

TRUCK ESCAPE RAMP W7-4 Image_Not_Available_SM 

TRUCK ESCAPE RAMP W7-4b Image_Not_Available_SM 

TRUCK ESCAPE RAMP W7-4c Image_Not_Available_SM 

TRUCK ESCAPE RAMP 

PLAQUE 
W7-4d Image_Not_Available_SM 

TRUCK ESCAPE RAMP 

PLAQUE 
W7-4e Image_Not_Available_SM 

TRUCK ESCAPE RAMP 

PLAQUE 
W7-4f Image_Not_Available_SM 

TRUCK LANE 500 FEET R4-6 R4-6_Truck Lane 500 Feet_SM 

TRUCK PARKING D9-16 Image_Not_Available_SM 

TRUCK ROLLOVER W1-13 Image_Not_Available_SM 

TRUCK ROUTE R14-1 R14-1_TRUCK ROUTE_SM 

TRUCK SPEED LIMIT R2-2 R2-2_TRUCK SPEED LIMIT_Sm 

TRUCKS USE RIGHT LANE R4-5 R4-5_Trucks Use Right Lane_SM 

T-SYMBOL W2-4 W2-4_T-SYMBOL_SM 

TURN W1-1L Image_Not_Available_SM 

TURN W1-1R W1-R1_TURN_SM 

TURN (ENGLISH) W1-1a L Image_Not_Available_SM 

TURN (ENGLISH) W1-1a R Image_Not_Available_SM 

TURN OFF 2-WAY RADIO 

AND CELL PHONE 
W22-2 Image_Not_Available_SM 

TURNING TRAFFIC MUST 

YIELD TO PEDESTRIANS 
R10-15 Image_Not_Available_SM 

TWO DIRECTION LARGE 

ARROW 
W1-7 

W1-7_TWO DIRECTION 

LARGE ARROW_SM 

TWO LANE REVERSE CURVE W1-4bL Image_Not_Available_SM 

TWO LANE REVERSE CURVE W1-4bR Image_Not_Available_SM 

TWO WAY LEFT TURN ONLY 

(GROUND MOUNTED) 
R3-9b 

R3-9b_Two Way Left Turn Only 

(Ground Mounted)_SM 

TWO WAY TRAFFIC W6-3 W6-3_TWO WAY TRAFFIC_SM 

TWO WAY TRAFFIC W6-4 Image_Not_Available_SM 

TWO-WAY LEFT TURN 

(OVERHEAD MOUNTED) 
R3-9a 

R3-9a_Two-Way Left (Overhead 

Mounted)_SM 

U.S. ROUTE MARKER FOR 

INDEPENDENT USE (1,2 

DIGITS) 

M1-4 Image_Not_Available_SM 

UNEVEN LANES W8-11 Image_Not_Available_SM 

USE CROSSWALK R9-3b Image_Not_Available_SM 

USE LANE WITH ARROW R10-8 Image_Not_Available_SM 

USE NEXT CROSSING W10-14a Image_Not_Available_SM 

UTILITY WORK AHEAD W21-7 Image_Not_Available_SM 

U-TURN PROHIBITED R3-4 
R3-4_U-TURN 

PROHIBITED_Sm 

U-TURN YIELD TO RIGHT 

TURN 
R10-16 Image_Not_Available_SM 

VAN ACCESSABLE R7-8a Image_Not_Available_SM 

VAN ACCESSABLE R7-8b Image_Not_Available_SM 

VEHICLES WITH LUGS 

PROHIBITED 
R5-5 Image_Not_Available_SM 

WALK ON LEFT FACING 

TRAFFIC 
R9-1 Image_Not_Available_SM 
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WEATHER ROUTE D12-1 Image_Not_Available_SM 

WEIGH STATION R13-1 Image_Not_Available_SM 

WEIGH STATION EXIT 

DIRECTION 
D8-3 Image_Not_Available_SM 

WEIGH STATION NEXT 

RIGHT (OPEN) (CLOSED) 
D8-2 Image_Not_Available_SM 

WEIGHT LIMIT R12-1 R12-1_WEIGHT LIMIT_SM 

WEIGHT LIMIT R12-3 Image_Not_Available_SM 

WEIGHT LIMIT R12-4 Image_Not_Available_SM 

WEIGHT LIMIT R12-5 Image_Not_Available_SM 

WELCOME CENTER D5-9a Image_Not_Available_SM 

WELFARE CENTER EM-6b Image_Not_Available_SM 

WHEN CHILDREN ARE 

PRESENT S4-2 
Image_Not_Available_SM 

WHEN FLASHING S4-4 Image_Not_Available_SM 

WHEN FLASHING W16-13 Image_Not_Available_SM 

WINDING ROAD W1-5L Image_Not_Available_SM 

WINDING ROAD W1-5R W1-5R_WINDING ROAD_SM 

WORKERS W21-1 Image_Not_Available_SM 

WORKERS W21-1a Image_Not_Available_SM 

WRONG WAY R5-1a R5-1a_WRONG WAY_SM 

YIELD R1-2 R1-2_YIELD_Sm 

YIELD AHEAD W3-2 Image_Not_Available_SM 

YIELD AHEAD W3-2a W3-2a_YIELD AHEAD_SM 

YIELD HERE TO 

PEDESTRIANS 
R1-5aL 

R1-5aL_YIELD HERE TO 

PEDESTRIANS_Sm 

YIELD HERE TO 

PEDESTRIANS 
R1-5aR 

R1-5aR_YIELD HERE TO 

PEDESTRIANS_Sm 

YIELD HERE TO 

PEDESTRIANS 
R1-5L 

R1-5L_YIELD HERE TO 

PEDESTRIANS_Sm 

YIELD HERE TO 

PEDESTRIANS 
R1-5R 

R1-5R_YIELD HERE TO 

PEDESTRIANS_Sm 

Y-SYMBOL W2-5 Image_Not_Available_SM 

 

 

 

 

 

 

 

 

IMPROVEMENT TYPE SUBTYPE AVG. COST 

STRIPING 

  

PAINT N/A 

THERMO N/A 

RAISED PAVEMENT 

MARKERS 

NONREFLECTIVE N/A 

REFLECTIVE N/A 

LEGENDS & SYMBOLS 

  

  

OTHER N/A 

ARROWS N/A 

BICYCLE N/A 



  

60 

 

  

  

  

  

  

  

  

  

  

DIAMOND N/A 

EXIT N/A 

STOP AHEAD N/A 

LANE ENDS N/A 

PEDESTRIAN CROSSING N/A 

RR CROSSING N/A 

SCHOOL CROSSING N/A 

SCHOOL ZONE N/A 

SHIELD N/A 

YIELD N/A 

 

 

 
CODE TYPE ID DESCRIPTION 

ROLE ADMIN SYSTEM ADMINISTRATOR 

ROLE PM PROJECT MANAGER 

ROLE PMSW PROJECT MANAGER STUDENT WORKER 

ROLE AE AREA ENGINEER 

ROLE USER GENERAL USER 

ROLE VIEW VIEWER 

SITE INT INTERSECTION 

SITE  NONINT NONINTERSECTION 

REGION DIST DISTRICT 

REGION PAR PARISH 

IMPROVEMENT SN SIGN 

IMPROVEMENT PV PAVEMENT MARKING 

APPROVAL Y ACCEPT 

APPROVAL N REJECT 

REASON C CONDITION 

REASON S SIZE INCREASE (SIGNS) 

REASON NI NEW INSTALL/MARKING 
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Installation of the Safety Evaluation Website 
Assumptions:  This web application is a Microsoft .Net application.  It has been installed and tested on 

Microsoft IIS versions 6 and 7.  The database is a Microsoft SQL Server database.  The backup database 

provided runs on Microsoft SQL Server 2008 R2. 

The installation guidance provided here involve the general steps to get the website setup.  There may be 

additional tasks that are necessary for a successful installation depending on the target environment. 

 

Installation 

1. Copy website folder to a location accessible by web server that will host the site. 

2. Create a website through the IIS manager.  (Steps will vary depending on version of IIS). 

 Note:  Ensure user account used to run the application pool has read/write access to the 

 database. 

3. Restore database backup to target database server that will host LASET database.  (Details will 

depend on environment) 

4. Modify web.config file in website to point to database restored in Step 3. 

a. Line 13 – change connection string by replacing <db server> with valid database server 

name. 

b. Line 13 – change connection string by replacing <database> with the valid database name. 
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LOGGING IN AND OFF 
The procedures in this section apply to all users. 

Log into LaSET 

1. Open an internet browser. 
2. Type http://lasetdev.lsu.edu in the address bar.  

The LaSET login page displays. 
 

 
Figure 1: Log in screen of LaSET. 

3. Enter the User ID and Password in their respective fields.  
4. Click Log In.  

The User Homepage displays with User Role and User Name displayed in the upper right of the 
page (see Figure 2). 
NOTE: Check the Remember ME? box to save the password for future logins.  
 

  
Figure 2: User Home page of LaSET. 

http://lasetdev.lsu.edu/
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Log off from LaSET 

1. Click Log off in the top right-hand corner of the home page.  
The LaSET Login page displays (see Figure 1). 

USER MANAGEMENT 
The procedures in this section, except for Password Reset by the User, apply to administrators. 

The procedures for Password Reset by the User apply to all users. 

Create a new User  

1. Click Users in the Options Menu. 
The User Management page displays. 
  

 
Figure 3: User Management page of LaSET. 

 

2. Click Create User. 
The Create a New User page displays. 
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Figure 4: Creating a new user. 

 

3. Enter all user information displayed. 
4. Select the appropriate Role Name of the user from the drop down box.  
5. Click Create.  

The User Created Confirmation page displays. 
 

 
Figure 5: User Created Confirmation and option of creating another user. 

6. Do you wish to create another user? 
 Yes- Select Create another User Account and go back to Step 3. 
 No- The process is complete. 
 

View Existing Users 

1. Click Users.  
2. The User Management displays (see Figure 3, p. 4). 

Proceed to Step 3 to sort by User Role. 
 OR 
Proceed to Step 4 to sort by columns. 
 OR 
Proceed to Step 6 to adjust the number of viewable records. 
 
Sort by User Role 

3. Select the desired User role from the User Role dropdown list. 
4. Click Filter.  

Users of only the selected user type are listed. 
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Figure 6: Sorting users by user type. 

 
 
 
 
Sort by Columns 

5. Click any column header to sort users, by that column, in ascending order. 
6. Click the same column header to sort users in descending order (if desired). 

 

 
Figure 7: Sorting users by column. 

 

Adjust the Number of Viewable Records 
7. Click the Record Number dropdown (located at the bottom of the page). 
8. Select the desired number of viewable records.  

The list increases/decreases based on selection. 
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Figure 8: Adjusting the number of viewable records. 

 

Edit a User 

1. Click Users.  
The User Management page displays (see Figure 3, p. 4).  

2. Locate the desired user in the list (see the Sort by User’s Role section for easier search). 
3. Click the Edit link that is associated with the user to be modified. 

The Edit User page displays.  
 

 
Figure 9: Edit User page 

 

4. Edit the appropriate information in the following fields:  
 Email address 
 First name 
 Last name 
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 Current Status dropdown menu (to Enable/Disable)  
 Role Name dropdown menu 

5. After making the desired changes, click Save.  
The User Update Confirmation message displays.  
NOTE: If changes are not required then click Back to List (see figure 9). 

6. If you wish to edit another user then click Edit another User and return to Step 2. 
 

 
Figure 10: User Update Confirmation and option of editing another user. 

 

Delete a User 

1. Click Users.  
The User Management page displays (see Figure 3, p. 4). 

2. Locate the desired user in the list (see the Sort by User’s Role section for easier search). 
3. Click the Delete link associated that is associated with the user to be deleted. 

The Delete User Confirmation page displays (see Figure 11, p. 8). 

 
Figure 11: Deleted User Confirmation and Cancel option. 

  
4. Click Delete to remove the user (or Cancel to avoid deletion).  

 

Password Reset by the System Administrator 

1. Click Users.  
The User Management page displays (see Figure 3, p. 5).  

2. Locate the desired user in the list (see the Sort by User’s Role section for easier search). 
3. Click the Reset Password link that is associated with appropriate user.  

The Reset Password page displays. 
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Figure 12: Reset password screen. 

 

4. Enter the new password in the New Password and Confirm Password fields. 

5. Click Save.  
The Password Reset Confirmation page displays. 
NOTE: Click Back to List to cancel the password reset process. 

6. Do you wish to reset another user password? 
 Yes- Click Reset Password for another User Account and return to Step 2. 
 No- The process is complete.   
 

 
Figure 13: Password reset confirmation creation confirmation. 

 
 

Password Reset by the User 

1. Click the User ID link in the top-right hand corner. 
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Figure 14: Home page of LaSET 

 

2. Enter the current password in the Current Password field. 
3. Enter the new password in the New Password and Confirm New Password fields. 

 

 
Figure 15: Change Password page 

 

4. Click Change Password.  
The Password Reset Confirmation page displays. 
 

 
Figure 16: Password reset confirmation creation confirmation. 

 

 
 

CREATING NEW PROJECTS AND SITES 

The procedures in this section apply to administrators, project managers and data entry users. 
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Create a New Project 

1. Click Projects in the Options Menu.  
The Project Management page displays. 
 

  
Figure 17: Project Management page 

 
2. Click Create Project in the top right-hand corner.  

The Create Project page displays.  
3. Enter the details of the new project in the following fields: 

 State Project Number (required to be in H.###### format) 
 Project Description 
 Project Cost 
 Contractor Information 

4. Click the Region Type dropdown and select from the following: 
 District 
 Parish 

5. Click the Region dropdown and make the appropriate selection: 
 If Region Type is District then select the appropriate district headquarters. 
 If Region Type is Parish then select the appropriate parish name. 

6. Click the Project Begin Date field (or select the dropdown arrow). 
A calendar displays.  
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Figure 18: Calendar. 
 

7. Select the appropriate date (or enter it in the MM/DD/YYYY format). 
NOTE: Click the left or right arrow, in the month/year calendar heading, to change months. 

8. Click the Project End Date field. 
A calendar displays. 

9. Repeat Steps 7 - 8 and then proceed to Step 10. 
10. Click Create.  

 

 
Figure 19: Create a new project. 

 

The Project Management page displays and the newly created project is reflected in the project 
list. 
 

  
Figure 20: Newly created project appears in the list. 

Create a New Project Site 

1. Click Sites in the Options Menu. 
The Sites Management page displays. 
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Figure 21: Sites Management page. 

 
2. Click Create Site.  

The Create Site page displays. 
 

 
Figure 22: Sites Management page 

 
3. Click the State Project Number dropdown and make the appropriate selection. 
4. Click the Parish Name dropdown and select the Parish in which the project site is located. 
5. Click the Site Type dropdown and select from the following: 

 Intersection 
 Non-Intersection 

6. Enter the details of the new project in the following fields: 
 Intersection ID/LRS ID (based on Site Type selection) 
 Site Name 
 Logmile From 
 Logmile To 

7. Click the Construction Begin Date field (or select the dropdown arrow). 
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A calendar displays (see Figure 18, p10).  
8. Select the appropriate date (or enter it in the MM/DD/YYYY format). 

NOTE: Click the left or right arrow, in the month/year calendar heading, to change months. 
9. Click the Construction End Date field. 

A calendar displays. 
10. Repeat Steps 7 -8 and then proceed to Step 10. 
11. Click Create. 

The Site Management page displays and the newly created project site is reflected in the list. 

Assign a Project Site to a Project Engineer 

1. Click Engineers in the Options Menu. 
The Project Engineer Management page displays. 
 

 
Figure 23: Project Engineer Management page. 

 

2. Click Assign Site to Project Engineer in the top right-hand corner. 
3. The Project Engineer Site Assignment page displays. 

 

 
Figure 24: Assigning a site to project engineer 

 

4. Click the Project Engineer’s User ID dropdown menu and select the desired user. 
5. Click the State Project Number dropdown menu and select the desired project number. 
6. Click the Site Name dropdown menu and select the desired site. 
7. Click Assign.  

The Project Engineer Management page displays and the new assignment is reflected in the list.  
NOTE: Click Cancel to cancel the assignment process. 



  

15 

 

 

Remove a Project Engineer Assignment from a Project Site 

1. Click Engineers in the Options Menu. 
The Project Engineer Management page displays. 

2. Click the Project Engineer’s User ID dropdown menu and select the desired user. 
3. Click Filter. 
4. Click the Revoke link located at the end of the row of the appropriate assignment (see Figure 23, 

p. 13).  
The Revoke Project Engineer’s Access page displays. 
 

 
Figure 25: Revoke a Project Engineer Assignment. 

 

5. Click Revoke. 
The Project Engineer Management page displays and the assignment is no longer listed. 
NOTE: Click Cancel to cancel the process. 

 

Assign a Project to a Data Entry User 

1. Click Data Entries in the Options Menu. 
The Data Entry Management page displays. 
 

 
Figure 26: Data Entry Management page. 

2. Click Assign Project to Data Entry. 
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The Data Entry Assignment page displays. 
 

 
Figure 27: Assigning a project to a data entry user. 

 

3. Click the Data Entry User dropdown and select the desired user. 
4. Click the State Project Number dropdown menu and select the desired project number. 
5. Click Assign.  

The Data Entry Management page displays and the new assignment is reflected in the list.  
NOTE: Click Cancel to cancel the assignment process. 

 

Remove a Data Entry User Assignment from a Project 

1. Click Data Entries in the Options Menu. 
The Data Entry Management page displays. 

2. Click the Data Entry User’s ID dropdown menu and select the desired user. 
3. Click Filter. 
4. Click the Revoke link located at the end of the row of the appropriate assignment.  

The Revoke Data Entry Access page displays. 
 

 
Figure 28: Revoke a Data Entry user assignment. 

 

5. Click Revoke. 
The Data Entry Management page displays and the assignment is no longer listed. 
NOTE: Click Cancel to cancel the process. 
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PROJECT SITE IMPROVEMENTS 
The procedures in this section apply to administrators, project managers and data entry users. 

View Site Improvements 

1. Click Sites in the Options Menu. 
The Sites Management page displays. 
 

 
Figure 29: The list of project sites. 

 

2. Click the Project dropdown and select the appropriate Project Number. 
3. Click Filter. 

Only project sites for the selected project number display in the list. 
NOTE: An Approval Status is displayed for each project site. The three status options are: 

= The project site improvements have been approved by the project engineer. 

= The project site improvements have been rejected by the project engineer. 

= The project site improvements have not been completed or the completed improvements 
are awaiting the project engineer’s review. 

4. Click the desired Site Name within the list.  
5. The Site Improvements page displays and reflects any previously added improvements and 

documents (see Figure 30, p. 17). 
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Figure 30: Project site improvements. 

 

Update Signage for a Project Site 

1. Complete Steps 1-5 in the View Site Improvements section (p. 16). 
2. Click Update a Sign at Site on the right-hand side of the page.  

The Update a Sign at Site page displays.  
 

 
Figure 31: Updating project site signage. 

 

3. Click the Sign name/code dropdown and select the desired sign from the list. 
4. Click the Sign Size dropdown and select the desired size from the list. 
5. Enter the number of selected signs, currently existing at the site, in Existing Sign Quantity. 
6. Click the Reason for Improvement drop-down and select one of the following options: 

 Condition 
 Other 
 New Install/Marking 
 Size Increase (Signs) 
NOTE: If New Install/Marking is selected then The Existing Sign Quantity should equal zero (0). 

7. Enter the number of signs (at the selected size), that will exist after improvements are made, in 
the Sign Quantity After Improvement field. 

8. Click Update.  

The Site Improvements page displays and reflects the new sign information.  
NOTE: Click Cancel to cancel the sign update process.  
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Edit Signage for a Project Site 

1. Complete Steps 1-5 in the View Site Improvements section (p. 16) if needed. 
2. Click the Edit link located near the end of the row of the appropriate sign. 

The Edit Signage page displays and all previously added sign information. 
3. Complete the appropriate steps, 3-7, in the previous section to properly edit the sign 

information. 
4. Click Save. 

The Site Improvements page displays and reflects the new sign information.  
NOTE: Click Cancel to cancel the edit process.  
 

Update Pavement Markings for a Project Site 

1. Complete Steps 1-5 in the View Site Improvements section (p. 16). 
2. Click Update Pavement Markings at Site on the right-hand side of the page.  

The Update Pavement Marking at Site page displays.  
 

 
Figure 32: Updating project site pavement markings. 

 

3. Click the Pavement Type dropdown and select the desired improvement from the list. 
4. Click the Reason for Improvement drop-down and select one of the following options: 

 Condition 
 Other 
 New Install/Marking 
 Size Increase (Signs) 

5. Click the Construction Type dropdown and select one of the following options: 
 New 
 Remove 
 Replace 

6. Click Update.  
The Site Improvements page displays and reflects the new pavement marking information.  
NOTE: Click Cancel to cancel the pavement marking update process. 

 

Remove Signage and Pavement Markings 

1. Complete Steps 1-5 in the View Site Improvements section (above). 
2. Click the Remove link located at the end of the row of the improvement to be removed.  

The Removal Confirmation page displays. 
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Figure 33: Remove improvements from a project site.  

3. Click Remove.  
The Site Improvements page displays and the improvement is no longer listed.  

 NOTE: Click Cancel to cancel the improvement removal process. 

 

Upload a Document for Site 

1. Complete Steps 1-5 in the View Site Improvements section (above). 
2. Click Upload a Document for Site on the right-hand side of the page.  

The Upload Document page displays.  
 

 
Figure 34: Uploading a document for a project site. 

 

NOTE: Only one PDF document can be saved for a project site. Uploading a document will overwrite 
an existing one. 

3. Click Browse (or Choose File, depending on the internet browser).  
A file explorer window opens. 
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Figure 35: Locating the appropriate file. 

4. Navigate to the folder that contains the appropriate PDF file. 
5. Select the file and click Open. 

The file explorer window closes and the file name displays to the right of the Browse button. 
6. Click Upload. 

The Site Improvements page displays with the viewable document.  
NOTE: Click Cancel to cancel the document upload process. 
  

UPDATE PROJECTS AND PROJECT SITES 
The procedures in this section apply to administrators, project managers and data entry users. 

Edit Project Details 

1. Click Projects in the Options Menu.  
The Project Management page displays.  

2. Click the Edit link associated with the desired state project number. 
The Edit Project page displays. 

3. Change any of the following: 
 State Project Number 
 Project Description 
 Project Cost 
 Region Type 
 Region 
 Contractor Information 
 Project Begin Date 
 Project End Date  

4. Click Save. 
The Project Management page displays and reflects all changes to the project details. 

 

Delete a Project 

1. Click Projects in the Options Menu.  
The Project Management page displays.  

2. Click the Delete link associated with the desired state project number. 
The Delete Project Confirmation page displays. 
 

 
Figure 36: Delete a Project Confirmation page. 

 

3. Click Delete.  
The Project Management page displays and the project is no longer listed. 
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NOTE: Click Cancel to cancel the deletion process. 

 
Important: A project cannot be deleted if sites are associated with it. Deleting such a project 
would result in the project’s deletion as well as all sites and improvements contained within the 
project. An error message displays if there is an attempt to delete such a project. 
 

Edit a Project Site 

1. Click Sites in the Options Menu.  
The Sites Management page displays.  

2. Click the Edit link associated with the desired project site. 
The Edit Site page displays. 

5. Change any of the following: 
 State Project Number 
 Parish Name 
 Site Type 
 Intersection ID / LRS ID 
 Site Name 
 Logmile From 
 Logmile To 
 Construction Begin Date 
 Construction End Date 

6. Click Save. 
The Site Management page displays and reflects all changes to the site details.  
 

Delete a Project Site 

1. Click Sites in the Options Menu.  
The Sites Management page displays.  

2. Click the Delete link associated with the desired project site. 
The Delete Site Confirmation page displays. 
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Figure 37: Delete a Project Site Confirmation page. 
 

3. Click Delete. 
The Site Management page displays and the project site is no longer listed. 
NOTE: Click Cancel to cancel the deletion process. 
 
IMPORTANT: A project site cannot be deleted if improvements have been added and are 
associated with it. An error message displays if there is an attempt to delete such a project site. 

 

PROJECT SITE APPROVAL 
The procedures in this section apply to project engineers. 

Post-Construction Site Approval 

1. Complete Steps 1-5 in the View Site Improvements section (above). 
 

 

 
Figure 38: Project Site Approval. 

 

2. Click Add Approval to for Site.  
The Update Approval for Site page displays.  
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Figure 39: Project site approval details. 

 

 
3. Click the Approval Status dropdown and select one of the following: 

 Accept 
 Reject 

4. Enter notes regarding the project site in the Reason Description field. 
5. Enter the total number of installed signs in the Sign Quantity of Approval field. 
6. Click Add.  

The Site Improvements and Approval page displays and the approval information is listed.  
NOTE: Click Cancel to cancel the approval process.  

Remove Post-Construction Site Approval 

1. Complete Steps 1-5 in the View Site Improvements section (above). 
2. Click Delete Approval to for Site.  

The Delete Approval for Site page displays.   
 

 
Figure 40: Deleting a prior project site’s approval. 

 

3. Click Delete.  
The Site Improvements and Approval page displays and the approval information is no longer 
listed.  

4. NOTE: Click Cancel to cancel the approval deletion process. 
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Upload Post-Improvement Photo for Site 

1. Complete Steps 1-5 in the View Site Improvements section (above). 
2. Click Upload a Post Improvement Document for Site on the right-hand side of the page.  

The Upload an Improvement Document page displays.  
 

 
Figure 41: Uploading photos for a project site. 

 

NOTE: Multiple JPEG files can be saved for a project site. Uploading additional photos will not 
overwrite any existing ones. 

3. Click Browse (or Choose File, depending on the internet browser).  
A file explorer window opens. 

4. Navigate to the folder that contains the appropriate JPEG file. 
5. Select the file and click Open. 

The file explorer window closes and the file name displays to the right of the Browse button. 
6. Click Upload. 
The Site Improvements and Approval page displays with the viewable photos.  
NOTE: Click Cancel to cancel the photo upload process. 

Remove Post-Improvement Photo for Site 

1. Complete Steps 1-5 in the View Site Improvements section (above). 
2. Scroll to locate the photo to be removed. 

 

 
Figure 42: Locating and deleting pot-improvement photos. 

 

3. Click the Remove link on the right side of the photo.  
The Photo Removal Confirmation page displays. 
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Figure 43: Confirming the removal of a project site’s photo. 

4. Click Remove.  
The Site Improvements and Approval page displays and the photo no appears.  
NOTE: Click Cancel to cancel the photo deletion process. 

 

VIEWER FUNCTIONALITIES 
The viewer user type provides read only access to all levels of user and project information. This includes 
current and completed projects.  

View Existing Users 

1. Click Users in the Options Menu.  
2. The User Management displays (see Figure 3, p. 4). 

Proceed to Step 3 to sort by User Role. 
 OR 
Proceed to Step 4 to sort by columns. 
 OR 
Proceed to Step 6 to adjust the number of viewable records. 
 
Sort by User Role 

3. Select the desired User role from the User Role dropdown list. 
4. Click Filter.  

Users of only the selected user type are listed. 
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Figure 44: Sorting users by user type. 

 

Sort by Columns 
5. Click any column header to sort users, by that column, in ascending order. 
6. Click the same column header to sort users in descending order (if desired). 

 

 
Figure 45: Sorting users by column. 

 

Adjust the Number of Viewable Records 
7. Click the Record Number dropdown (located at the bottom of the page). 
8. Select the desired number of viewable records.  

The list increases/decreases based on selection. 
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Figure 46: Adjusting the number of viewable records. 

 

 
 
 
 
 

View Projects 

1. Click Projects in the Options Menu.  
The Project Management page displays. 
 

 
Figure 47: Project Management page 

 

2. View the following project information: 
 State Project Number 
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 Project Description 
 Project Cost 
 Region Type 
 Region 
 Contractor Information 
 Project Begin Date 
 Project End Date 
 Project Created Date 
 Project Created By 
 Project Last Updated Date 
 Project Last Updated By 

3. Click the desired State Project Number within the list to display this information for 
one project. 
 

 
Figure 48: Project Details page 

View Project Sites and Site Improvements 

1. Click Sites in the Options Menu. 
The Sites Management page displays. 
 

 
Figure 49: The list of project sites. 

 

2. Click the Project dropdown and select the appropriate Project Number. 
3. Click Filter. 

Only project sites for the selected project number display in the list. 
NOTE: An Approval Status is displayed for each project site. The three status options are: 

: The project site improvements have been approved by the project engineer. 

: The project site improvements have been rejected by the project engineer. 
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: The project site improvements have not been completed or the completed improvements 
are awaiting the project engineer’s review. 

4. Click the desired Site Name within the list.  
5. The Site Improvements page displays and reflects any previously added 

improvements, documents and photographs. 
 

 
Figure 50: Project site improvements. 

View Project Engineer Site Assignments 

1. Click Engineers in the Options Menu. 
The Project Engineer Management page displays. 
 

 
Figure 51: Project Engineer Management page. 

 

2. View the following assignment information: 
 Project Engineer’s User ID 
 State Project Number 
 Site Name 
 Site Assigned Date 
 Site Assigned By 

3. (Optional) Click the Project Engineer or Project dropdown menu and select the desired user or 
project. 
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4. Click Filter. 
If filtered by Project Engineer then the list displays all project sites assigned to the selected user. 
If filtered by Project then the list displays only projects site assignments that fall under the 
selected project number. 

View Data Entry Project Assignments 

1. Click Data Entries in the Options Menu. 
The Data Entry Management page displays. 

 
Figure 52: Data Entry Management page. 

 

2. View the following assignment information: 
 Data Entry’s User ID 
 State Project Number 
 Site Name 
 Site Assigned Date 
 Site Assigned By 

3. (Optional) Click the Data Entry or Project dropdown menu and select the desired user or project. 
4. Click Filter. 

If filtered by Data Entry then the list displays all projects assigned to the selected user. 
If filtered by Project then then list displays all data entry users assigned to the selected project 
number. 

 

CRASH ANALYSIS 
The analysis objectives for the tool are to easily search for safety improvement locations, retrieve “before 
and after” crash analysis results and export analysis results.  

Filtering and Sorting Site List 

1. Click Analysis in the Options Menu.  
A list of all project sites displays. 
Proceed to Step 2 to filter by Parish. 
 OR 
Proceed to Step 4 to sort by columns. 
 OR 
Proceed to Step 6 to adjust the number of viewable records. 
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Sort by Parish 
2. Click the Parish dropdown menu and select the desired parish. 
3. Click Filter. 

 
Figure 53: Sorting Sites by Parish 

 
Sort by Columns 

4. Click any column header to sort sites, by that column, in ascending order. 
5. Click the same column header to sort users in descending order (if desired). 

 

 
Figure 54: Sorting Sites by Column 

 
Adjust the Number of Viewable Records 

6. Click the Record Number dropdown (located at the bottom of the page). 
7. Select the desired number of viewable records.  

The list increases/decreases based on selection. 
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Figure 55: Adjusting the number of viewable records. 

 

Selecting Sites for Analysis 

1. Click the Select box that corresponds to the site(s) to be analyzed. 
2. Select the number of years to be analyzed from the Period Duration dropdown list. 

NOTE: This number represents the number of years to be analyzed before safety improvements 
were made at the location and the number of years after the safety improvements were 
complete. 

3. Click Predict. 
The Predictive Results page displays. 

 
 
 

Viewing Analysis Results 

1. Review the Selected section for an overview of the sites selected for analysis. 
2. View the Results Per Period section for the before and after results of the time span selected. This 

includes:
 State Project Number 

 Intersection ID / LRS ID 
 Site Name 
 Site Type 
 Logmile From 
 Logmile To 
 Period 
 Begin Date 
 End Date 

 Total Observed 
 Total Predicted 
 Total Expected 
 Average Observed 
 Average Predicted 
 Average Expected 
 K 
 W 

3. View the Results Per Year section for the before and after results for each individual year within 
the time span selected. This includes: 

 State Project Number 
 Intersection ID / LRS ID 
 Site Name 

 Site Type 
 Logmile From 
 Logmile To 
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 Period 
 Year Begin/End Date 

 Observed 
 SPF 
 Predicted 

 AADT (minor, major) 
 K 
 C 
 CMF

4. View the Log Information section for missing information, in the analysis calculations, that were 
replaced with default values (and could alter the final results). 

Exporting Analysis Results 

The analysis results can be exported to Microsoft Excel, but must be done for each section 

(Results Per Period, Results Per Year and Log Information). The process of exporting the data is 

optimized for Google Chrome and Mozilla Firefox. Recent releases of Microsoft Internet 

Explorer to not support the Export functionality. 

1. Identify the web browser of choice.  
Proceed to Step 2 to export with Google Chrome. 
 OR 
Proceed to Step 4 to export with Mozilla Firefox. 
 OR 
Proceed to Step 8 to export with Microsoft Internet Explorer. 
 
Export with Google Chrome 

2. Click the Export Data to Excel button located below the appropriate section heading. 
The file automatically downloads. 
 

 
Figure 56: The downloaded file from exporting in Chrome. 

 

3. Click the download file. 
Microsoft Excel opens and reflects the same information that is viewable in the browser. 
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Figure 57: The exported results in Microsoft Excel. 

 

Export with Mozilla Firefox 
4. Click the Export Data to Excel button located below the appropriate section heading. 

A new window displays. 
 

 
Figure 58: Exporting the results with Firefox. 

5. Click the Open with radial button. 
6. Choose Microsoft Excel from the dropdown menu. 
7. Click OK. 

Microsoft Excel opens and reflects the same information that is viewable in the browser. 
 

 
Figure 58: The exported results in Microsoft Excel. 

 
Export with Microsoft Internet Explorer 
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8. Highlight the data that you wish to export: Left-click the upper left corner of the data, hold the 

mouse button down while dragging the cursor down to the bottom right corner of the data and 

release the mouse button.  
 

 
Figure 59: Highlighting the data within the browser. 

 

9. Right-click within the data. 

A popup menu displays. 

 
Figure 60: Copying the data within the browser. 

10. Click Copy. 
11. Open Microsoft Excel. 
12. Right-click within the spreadsheet. 

A popup menu displays. 
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Figure 60: Pasting the data within the browser. 

 
13. Click the preferable Paste Icon. 

Microsoft Excel reflects the same information that is viewable in the browser. 
 

 
Figure 61: The pasted information in Microsoft Excel. 

 
 



This public document is published at a total cost of $250 
42 copies of this public document were published in this fi rst 
printing at a cost of $250.  The total cost of all printings of 
this document including reprints is $250.  This document was 
published by Louisiana Transportation Research Center to 
report and publish research fi ndings as required in R.S. 48:105.  
This material was duplicated in accordance with standards for 
printing by state agencies established pursuant to R.S. 43:31.  
Printing of this material was purchased in accordance with the 
provisions of Title 43 of the Louisiana Revised Statutes.


